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Engineering Module
The Engineering (ENGM) Module is comprised of several applications that allow for communication and 
management of engineering information, including items and bills of material, from designing to 
manufacturing. This streamlined engineering management minimizes the number of new parts introduced 
into the system, reduces the cost of product changes, and also reduces the product time to market. 
Engineering Module applications include the following:

• Item Master

• Bill of Material 

• Bill of Material Analysis

• Engineering Administrative Tools

• Product Release Management

• Workflow Management

Module Prerequisites
The Engineering Module has the following prerequisites:

• SYSM (System Control)

• BILM (Bill of Material)

External Software
The Engineering Module is fully functional without the need for any external software. But, several 
types of external software requirements exist for the ENGM Module based on how you wish to use 
functionality available within the module.

Functionality Software Requirement

Modify predefined report templates or create your 
own custom report templates

Crystal Reports Professional (32-bit technology)

Use E-mail to deliver the notifications generated 
when a workflow process is routed.

MAPI-compliant electronic mail system, such as 
Microsoft Exchange or Outlook
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Setting Up the Engineering Module
Setting Up the Engineering Module provides an overview of how to implement the module. It 
covers:

• guidelines to consider before you implement the module

• how to prepare your data for loading

• suggested procedures for loading your data

• suggestions for using the module

Although this section provides key information about the Engineering Module, it does not explain 
manufacturing principles and concepts such as how to structure your bills of material or 
engineering principles such as implementing or managing workflow processes.

Before You Implement the Module
The item master and bills of material provide the framework for the entire manufacturing planning 
process. The Engineering Module (ENGM) extends this functionality by providing product 
definition, which includes separate item masters and bills of material for engineering items and 
production items and includes a managed release of engineering items into the production 
environment. The Engineering Module also provides for workflow management, including the 
creation, routing, and disposition of workflow processes. 

Item Master Information
• Each item used to build your products should have a unique item number, and the information 

about each item should be accurate. An item must be defined as either an engineering item or 
production item.

If an item numbering scheme does not already exist, define a numbering scheme that uses as 
few characters as possible. For example, a company with up to 10,000 items needs a four-
character item number.

• Collect item packaging information including standard package type, weight, volume and 
pieces per package. The unit of weight and volume used to enter item packaging information 
must be the same across all items. Be consistent in assigning packaging information for 
standard units of measure so that weight/volume accumulations are accurate.

• Procedures should be established for collecting item information and entering this data into 
the computer. As changes to item information are made, these changes must also be entered 
into the computer. Procedures should cover the different aspects of item information, such as 
engineering specifications, planning parameters and costing data.

• Guidelines and responsibility should be established for maintaining item information related to 
engineering specifications, such as assignment of the item number and item description.

• Guidelines and responsibility should be established for maintaining item information related to 
planning parameters, such as the determination of order policy, order modifiers and lead 
times.

Bills of Material Information
• Bills of material information can be maintained from both the Engineering Module and the Bills 

of Material Module (BILM), but it is recommended that only one of these is used for 
Engineering 5
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maintaining bills. Procedures should be established for determining where a bill of material 
information is maintained.

• Verify that your bills of material accurately reflect how your products are built. A bill of material 
must be defined as either an engineering bill of material or production bill of material.

• As changes to your products are made, the bills of material are updated. Procedures should 
be established for additions, changes and deletions to your bills of material. Each planned 
change should be indicated by the date on which the change is scheduled to become 
effective.

• Procedures should be established for tracking revision history within the bills of material.

• Procedures should be established for determining unique reference designators associated 
with component lines on each bill of material.

Product Release Information
• Guidelines should be established for releasing products from one phase to the next phase.

• Procedures should be determined for establishing product release conditions and rules. 
Conditions, such as not allowing costs to equal zero for buy items or not allowing labor to 
equal zero for make items, should be assigned to rules.

• Procedures should be determined for establishing costs on the ITMC screen for engineering 
items that have been promoted into production. Engineering items promoted into production 
do not have a cost record assigned.

Workflow Information
• Procedures should be determined for establishing administrator responsibilities, such as 

setting up and maintaining routing templates and processes.

• Procedures should be established for collecting and entering approved process information, 
such as engineering change requests, into the system.

• Procedures and responsibilities should be established for maintaining and verifying workflow 
information associated with actual components on the bills of material.

• Procedures should be established for using the sample workflow data that is included in a 
sample database available with the Engineering Module. Sample data includes pre-defined 
users, groups, activities, documents and routing templates. The sample database also 
includes pre-defined workflow assignments, such as users assigned to groups, groups 
assigned to activities and activities assigned to routing templates.

• Develop a testing plan to verify the accuracy of entered information.

Preparing Your Data for Loading
Information about your bills of material and workflow processes may exist in a variety of forms. 
There is no "one best method" for preparing this data. The following suggestions will help minimize 
data entry time and effort when you enter the data during startup.

A suitable data entry form should have data in the same sequence as that of the fields used to 
enter the data into the computer. Check your source documents to see if they can be used for data 
entry purposes, and then decide whether or not to transcribe the information onto forms before 
entering it into the computer.

The following supplemental suggestions are tailored for the Engineering Module.
Engineering 6
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Item Master
Review item master information used by the Inventory Control Module. 

• Items must be defined as either engineering or production items.

• Determine the production DEFAULT-ITEM information, including a planner and buyer. The 
default planner and buyer identifier can be used during the product release phase to remind 
the user that the default identifier must be replaced with a valid identifier when an item is 
promoted from pre-production to production.

Bills of Material
Review bills of material information used by the Bill of Material Module. A bill of material must be 
defined as either an engineering bill of material or a production bill of material.

You should ensure that your bills of material are accurate before preparing your engineering 
information for loading. A common method of evaluating bill of material accuracy is to compare 
your bill of material information with the way that products are actually manufactured for a selected 
subset of assemblies. As a target, bill of material accuracy should be maintained at a level of 99 
percent or better. If your bills of material are not accurate, you should correct them in the process 
of preparing your data for loading.

Reference Designators
Reference designators are unique identifiers which allow engineers to assign control information, 
such as device callouts, to a component within the bill of material. Reference designator ranges 
can be used to organize multiple sequential reference designator identifiers for a component or 
subassembly. 

For example, on a circuit board, a reference designator can be assigned to a specific location into 
which a component must be inserted. Processes and instructions involving the circuit boards refer 
to the reference designators, including the engineering design and assembly instructions as well 
as the manual and automated insertion processes. Reference designators are defined in lists and 
ranges. The Engineering Module does not allow reference designators to be duplicated within a 
bill of material for an effectivity date range.

Determine the reference designator identifiers and ranges needed to support your engineering 
control policies. See Reference Designators in Suggestions for Using the Module for additional 
information.

Product Release Information
Use the procedures established in Before You Implement the Module to prepare your product 
release information for loading.

• Determine the names of the three levels, or phases, of product release for your company.

• Define the product release conditions which identify the selection or edit criteria for selecting 
the item for promotion.

• Define the product release rules which identify the requirements needed for an item to be 
promoted to the next level.

Use the examples included in Product Release Management as a reference or starting point while 
preparing this release information. 

Workflow Information
Engineering 7
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Use the procedures established in Before You Implement the Module to prepare your Workflow 
information for loading.

Routing Templates
Identify the routing template information for your system, including 

• determine which users are involved in the workflow process

• identify groups and assign users to groups

• identify activities and assign groups to activities

• identify and assign activities and documents to routing templates

Use the sample database as a reference or starting point while preparing this routing template 
information. Routing template information includes:

Process and Disposition
Identify the process and disposition information for your system, including 

• determine view preferences for displaying processes and disposition information using various 
filters

• if you use an electronic mail system for routing a process, determine your electronic mail 
delivery requirements

Loading Your Data
Once your data has been prepared for entry, use this section to load your data into the 
Engineering module.

A validation tool is identified for each screen or task listed in this section. Use the validation tool 
to double-check the accuracy of the data you have entered. Validation tools include:

• Screen reports. Create these reports by choosing Print from the File menu. For more 
information, see "Screen Reports" in the Fourth Shift Basics manual.

• Print screens. When other report options are not available, you can capture an image of your 
screen and use it to validate your data entry. For more information, see "Using the Print 
Screen Key" in the Fourth Shift Basics manual.

Other validation tools, such as batch processes and data extracts, may also be listed.

Type Information

Users identifier, name, electronic mail identifier, and address and 
group assignments

Groups titles, descriptions, and activity assignments

Activities titles, descriptions, and routing assignments

Documents titles, descriptions, and routing assignments

Routing templates titles, descriptions, process prefix number, and starting pro-
cess number
Engineering 8
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1. Verify or Enter Item Master Information

2. Verify or Enter Bill of Material Information

3. Check Security

Activity Location Module Description Validation Tool

PITB ENGM production item master informa-
tion

Quick Print

production DEFAULT-ITEM infor-
mation

Quick Print

Production tab ENGM production item master detail 
information

Quick Print

EITB ENGM engineering item master informa-
tion

Quick Print

Engineering tab ENGM engineering item master detail 
information

Quick Print

Activity Location Module Description Validation Tool

PBLL ENGM production bill of material infor-
mation for each parent item

report

Production + Comp Detail ENGM production component text and 
detail information

report

EBLL ENGM engineering bill of material infor-
mation for each parent item

report

Engineering + Comp Detail ENGM engineering component text and 
detail information

report

Activity Location Module Description Validation Tool

PASS and FCMT SYSM password and authorized access 
codes for each user for access-
ing Product Definition

Screen report

password and authorized access 
codes for each user for access-
ing Product Release Manage-
ment

Screen report

password and authorized access 
codes for each user for access-
ing Workflow Management

Screen report
Engineering 9
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4. Set Up Product Definition Options

5. Enter Reference Designators

6. Verify Reference Designators

7. Set Up Product Release Phases

8. Enter Product Release Rules

9. Prepare Your Electronic Mail System

Activity Location Module Description Validation Tool

Options from the View menu 
(from Bill of Material)

ENGM general options, including record 
sorting and effectivity date filter-
ing of components

print screen

reference designator options print screen

lead time options print screen

Activity Location Module Description Validation Tool

PBLL or EBLL + Engineering + 
Ref Des

ENGM reference designators and text 
for each component

report

Activity Location Module Description Validation Tool

Components ENGM sort bill of material by Reference 
Designators

report

PBLL or EBLL + Engineering + 
Ref Des 

ENGM Single Level Bill with Reference 
Designators report

report

Activity Location Module Description Validation Tool

Modify Phase Names from the 
Edit menu PRRD

ENGM names of three product release 
phases

none

Activity Location Module Description Validation Tool

PRRD ENGM selection and edit conditions to 
promote items

none

assign conditions to rules none
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If you use an electronic mail system for workflow management, contact your electronic mail 
system administrator to complete the following.

10. Define Workflow Users

11. Define Workflow Groups

12. Define Workflow Activities

Activity Location Module Description Validation Tool

MAPI-compliant electronic mail 
system

n/a create a personal folder for the 
workflow administrator

none

set the delivery option to "per-
sonal folders" for the workflow 
administrator

none

create a mail identifier for each 
user involved in workflow

Activity Location Module Description Validation Tool

WKFL ENGM define users
use the sample database, if 
desired

none

if you use an electronic mail 
system for workflow, define 
a Mail Id, or alias, for each 
internal user involved in 
workflow.

none

if you use an electronic mail 
system for workflow, define 
a fully qualified Mail Id and 
Mail Address for each 
external user involved in 
workflow.

none

Activity Location Module Description Validation Tool

WKFL ENGM define groups
use the sample database, if 
desired

none

Activity Location Module Description Validation Tool

WKFL ENGM define activities
use the sample database, if 
desired

none
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13. Define Workflow Documents

14. Define Routing Templates

15. Define Routing Assignments

16. Customize Process Status and Disposition Views

17. Test Workflow Process

Activity Location Module Description Validation Tool

WKFL ENGM define documents
use the sample database, if 
desired

none

Activity Location Module Description Validation Tool

WKFL ENGM determine process number prefix 
and starting process number

none

define routing templates
use the sample database, if 
desired

none

determine startup message for 
electronic mail notifications

Activity Location Module Description Validation Tool

WKFL ENGM assign users to groups none

assign groups to activities none

assign activities to routing tem-
plates

none

assign documents to routing tem-
plates

none

Activity Location Module Description Validation Tool

ECRA Process Status and Dis-
position

ENGM customize views using filtering 
options

none

Activity Location Module Description Validation Tool

ECRA Process Status and Dis-
position

ENGM test the workflow process from 
creation to disposition

none
Engineering 12
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Suggestions for Using the Module
The ways in which the Engineering Module is used vary from company to company. The following 
guidelines may be helpful for using the module in your company.

Access Methods
Several methods are available for accessing the features in the Engineering and Manufacturing 
Analysis modules. Access methods allow users to choose how to open the available features.

The Engineering and Manufacturing Analysis modules are designed as multi-user applications. 
They do not run in single-user mode. 

Accessing from Fourth Shift
You can access the features from within Fourth Shift using the following function codes. Function 
codes in the ENGM Module differ based on whether the feature is engineering or production.

Accessing from the Module
You can navigate around the features from within the module using the following methods:

Feature
Function Code for 

ENGM
Function Code for 

MMAM

Bill of Material EBLL/EBLI, PBLL/PBLI ASBL

Comparison Bill ECMP, PCMP ASBC

Comparison of Summarized Bills ECMS, PCMS

Engineering Data Import EIMP

Engineering Database Administration EDBA

Item Master EITB/EITI, PITB/PITI

Multi-Level Bill EMLB, PMLB AMBL

Multi-Level Costed Bill ECRL, PCRL

Multi-Level Where Used EMWU, PMWU

Process Status and Disposition ECRA/ECRD

Product Release Rule Definitions PRRD

Routing Template Administration WKFL

Summarized Bill ESMB, PSMB SUMB

Where Used EWUS, PWUS

Method Access Description

Go To Frame Accessed from the File menu 
or the toolbar.

Allows users to select and go to another fea-
ture.

Graphical Bill Accessed by selecting an item 
within the graphical bill and 
then clicking the right mouse 
button.

Allows users to select a feature and then 
opens the feature using the selected item 
information.
Engineering 13
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Accessing from the Start Menu
You can access the features from the Start menu. Click the Start button, and then point to 
Programs. Point to the folder that contains the Fourth Shift group, then point to one of the following 
modules and select a group and/or feature:

Accessing from the Desktop
You can access the features from the desktop by copying the shortcuts from the Start Menu. The 
shortcuts use the following executable files that are located in the MFGSYS\SYSTEM directory:

Engineering Module Processing Flows
The Engineering Module includes several processing flows.

ENGM Module Flow
The ENGM Module general flow looks similar to the following:

Module Group / Features

Engineering Product Definition – Engineering

Product Definition - Production

Product Release Management

Workflow Management

Manufacturing Analysis Bill of Material

Comparison Bill

Multi-Level Bill of Material

Summarized Bill

Module Features

ENGM
(Product Definition)

Product Definition

Engineering Database Administration

Engineering Data Import

ENGM
(Product Release Management)

Product Release Rule Definitions

ENGM
(Workflow Management)

Routing Template Administration 

Process Status and Disposition

MMAM ALL
Engineering 14
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Product Definition Flow
The Production Definition flow looks similar to the following:

Product Definition

Workflow Management

Product Release Management

items

bills

Production
tables

Engineering
tables

rules

release

define items and bills of material
and import engineering data

release items from engineering into production

create workflows and communicate results

EWUSPWUS

ECMPPCMP

Analyze bills of material:

Analyze bills of material where used information

EITBPITB Define items and item detail
and copy production items to engineering

EDBA
Use engineering administrative tools:
- create user-defined fields
- import engineering data

EIMP

PCMS ECMS

PSMB ESMB

PMLB

EMWU

EMLB

PMWU

EBLLPBLL
Define bills of material
and copy production bills of material to engineering

PCRL ECRL - simulate an engineering cost roll

- compare summarized bills of material

- summarize bills of material

- compare bills of material by parent, effectivity date or revision
Engineering 15
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Product Release Management Flow
The Production Release Management flow looks similar to the following:

Workflow Management Flow
The Workflow Management flow looks similar to the following:

PRRD Define conditions and rules for releasing products.

EITBPITB Release products to the next phase.

Phase 1 Phase 2 Phase 3

Define users, groups, activities, routing templates

Assign workflow relationships

Create a Routing Template  (Administrators only)

Create a New Process (Administrators only)

Attach process specific documents

Route the process

Review process documents

Should approval be given for this process?Yes

No

Attach or update documents to support
rejection disposition

Should the process be restarted?

Define document templates

Yes

No

Process is not restarted, original
disposition is final

Reject the process; enter rejection
comments

Approve the process; enter
approval comments

Attach or update documents to
support approval disposition

No

Yes Are there any more activities?

WKFL

ECRA

Create a process based on a routing template

Disposition the Process (All users involved)ECRD

ECRA Process is restarted by system
administrator
Engineering 16
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Product Definition Detail
Product Definition includes the following feature details:

Engineering and Production Environments
The Engineering Module includes items and bills of material for both engineering and production 
environments. Engineering item data can be linked to production item data, allowing design and 
manufacture engineers to view their data in the same bill of material and item structures. For 
example, components on engineering bills can be associated with engineering oriented item data, 
such as design specifications or inspection checklists.

Use the following information to review the different environments.

• Engineering environments involve item designs and item prototypes that are created to 
prove functional and structural design strategies. Engineering data, such as manufacturer's 
part numbers, generic part numbers, estimated costs and reference designators, are used to 
further define the item. Engineering environments are often rapidly changing in order to keep 
improving their designs and prototypes to ensure the future of their product.

• Production environments involve the stages of the manufacturing process, such as MRP 
planning. Production data, such as item numbers, standard costs, lead times and quantities, 
are used within the MRP planning process. Production environments are usually controlled 
and structured in order to provide their company with a consistent day-to-day working 
situation.

Field Label Prefixes
Engineering and production fields can be added to an item master or bill of material to provide 
additional information or for comparison purposes. For example, you can add the Item field from 
the production item master to the engineering item master in order to compare engineering and 
production item identifiers.

Prefixes are used in the field labels to distinguish item master fields. Field label prefixes include 
the following:

Text Messages
Text messages can be maintained and used in both the production and engineering environments. 
The following types of text are available from the Item Master, Bill of Material, Multi-Level Bill, 
Where Used and Multi-Level Where Used screens:

Field Field Prefix Description

production no prefix

engineering * (one asterisk)

user-defined ** (two asterisks)

Text Type Tabs that Include Text

Component Detail Production + Comp Detail
Engineering + Comp Detail

Item Detail Production + References

Planning Detail Production + Plng Dtl

Lot Trace (view only) Lot Trace + Detail
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Text messages are limited to four lines of 60 characters each. The Text dialog box includes a 
Where Used Count value which identifies the number of records to which the text is attached. To 
view this list of records, click Where Used.

In order to maintain text messages, users must be assigned security access to the TXWU (Text 
Where Used) screen. Use the FCMT (Function Code Maintenance) screen to assign security 
access.

Customized Column Layout
Column layout can be customized based on your company's requirements. From the Edit menu, 
select Columns to define column layout, including:

Sort Order
You can create a customized sort order of a table by double-clicking the heading for the column by 
which you want to sort records. The records are automatically sorted and redisplayed. A chevron 
in the upper right corner identifies the current sort column. A sort order is saved when the view is 
saved using the Save Current View icon.

Splitter Bar
You can create a non-scrolling area in the table using the splitter bar. Columns to the left of the 
splitter bar do not scroll when the user scrolls to the far right of the table. A splitter bar position is 
saved when the view is saved using the Save Current View icon. A splitter bar is not available on 
tables with a two-row header.

• Add Splitter Bar. Point to the vertical bar located immediately to the left of the first column 
heading. Drag and drop bar to the desired column location.

• Remove Splitter Bar. Any changes to the columns removes the splitter bar. Alternatively, 
from the Edit menu, choose Columns. Click Restore Defaults then click OK to remove the 
splitter bar.

Global and Local Views
Views can be defined to capture customized column layouts of the Product Definition features, 
such as the item master or bills of material. Several view types are available, including:

Option Description

Available Columns Review the list of engineering, production and user-defined fields available.

Show these Columns Use arrows to specify which fields from "Available Columns" to include on the 
grid. 

- Columns are added where your cursor is positioned in "Show these 
Columns."

- Columns are displayed in the grid based on the "Show these Columns" sort 
order.

Use Move Up and Move Down to re-sort the order of the columns, if desired.

Show on row 2 Select which fields to display on the second header row, if a two-row header is 
desired.

Restore Defaults Use Restore Defaults to revert back to the default column layout.

View type Description

Default View is displayed automatically when the feature is accessed

Global View can be accessed by other users
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Views are displayed in the toolbar View List under the appropriate heading, either Global and 
Local. Reports can also be associated with each view to capture the customized layout in a 
printable format.

Reference Designators
Reference designators are engineering "location tools" which allow engineering control 
information, such as location detail, to be added to a component or subassembly. For example, 
reference designators can be used to specify exact locations on assembly drawings, data packs or 
insertion machine sequencing programs. 

Reference designator information is accessed from the Bill of Material on the Engineering tab. 
Reference designators can be entered, reviewed and validated for each component on a bill of 
material. Reference designators are defined using an identifier and sequence number.

Reference designators assigned to components are included when components from one bill of 
material are copied to another bill of material, using the File menu and selecting Copy Bill of 
Material. Additional reference designator selection and editing capabilities are available when 
using the Copy Buffer feature. 

Reference Designator Text
User-defined engineering information can be associated with a specific reference designator for a 
component on a bill of material. Engineering information can include, for example, component 
location, orientation or detailed insertion instructions. Enter user-defined engineering information 
in the Text field. 

Reference Designator Ranges
Reference designators can be entered in ranges in order to organize multiple reference designator 
identifiers for a component or subassembly. You should group similar types of reference 
designators in a range to provide a quick way of locating identifiers.

For example, to create a range of reference designators while positioned in the Ref Des field, from 
the Edit menu, choose Create Ref Des Range. The Create Ref Des Range dialog opens and you 
can enter reference designator ranges using From and Through identifiers. 

• The From identifier includes a prefix that must include at least one non-numeric character. 
The last character must be numeric because it defines the first number in the range. The From 
identifier prefix is assumed in the Through identifier. 

• The Through identifier is numeric and defines the last number in the range. 

Examples of reference designator ranges include:

Reference Designator Options

Local View can only be accessed from the machine on which it was created; neither 
default or global is selected

From Entry Through Entry Range Includes

R250 255 R250, R251, R252, R253, R254, 
R255

3*x1 4 3*x1, 3*x2, 3*x3, 3*x4
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You can customize the reference designator features by selecting Options from the View menu. 
Options include setting the single separator string, reference designator range details and 
reference designator display count values.

User-Defined Fields: Format Property (Access only)
The Format property is available in the Engineering Module when using the Engineering 
Database Administration feature to format user-definable fields. The Format property is supported 
by MS Access column properties and allows you to customize the way numbers, dates, times and 
text are displayed and printed. The Format property effects only how data is displayed and printed, 
and not how data is stored in the database. Data types are used to specify different methods of 
formatting.

The Format property is available only if you are using Engineering in a MS Access database 
configuration.

Predefined Formats in ENGM
The Engineering Database Administration feature provides predefined formats for the Date/Time 
and Number and Currency data types. The Engineering Module displays formats appropriate for 
the country specified in the Regional Settings dialog in the Control Panel. Custom formats 
inconsistent with the Regional Settings dialog are not used.

For example, the following displays for a Currency data type:

The Engineering Module allows the use of the following symbols to format any data type:

Note: Formatting symbols for the Number and Currency data type cannot be combined or 
mixed with formatting symbols for Date/Time, Yes/No, or Text and Memo data types.

Date/Time Data Format
Use the following symbols for Date and Time formatting:

Country Currency Value Display Result

English (United States) 1234.56 $1,234.56

English (British) 1234.56 £1,234.56

Symbol Meaning

(space) Display spaces as literal characters.

"ABC" Display anything inside quotation marks as literal characters.

! Force left alignment instead of right alignment.

* Fill available space with the next character.

\ Display the next character as a literal character. Display literal characters by 
placing quotation marks around them.

[color] Display the formatted data in the color specified between the brackets. Available 
colors: Black, Blue, Green, Cyan, Red, Magenta, Yellow, White. (not supported in 
ENGM)

Symbol Description
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Note: To add a comma or other separator to your custom date format, enclose the separator 
in quotation marks, for example: mmm d", "yyyy.

Number and Currency Data Format

: (colon) Time separator. Defined by Regional Settings Properties in the Control Panel

/ Date separator

c Same as the General Date predefined format

d Day of the month in one or two numeric digits, as needed (1 to 31)

dd Day of the month in two numeric digits (01 to 31)

ddd First three letters of the weekday (Sun to Sat)

dddd Full name of the weekday (Sunday to Saturday)

ddddd Same as the Short Date predefined format

dddddd Same as the Long Date predefined format

w Day of the week (1 to 7)

ww Week of the year (1 to 53)

m Month of the year in one or two numeric digits (1 to 12)

mm Month of the year in two numeric digits (01 to 12)

mmm First three letters of the month (Jan to Dec)

mmmm Full name of the month (January to December)

q Date displayed as the quarter of the year (1 to 4)

y Number of the day of the year (1 to 366)

yy Last two digits of the year (01 to 99)

yyyy Full year (0100 to 9999)

h Hour in one or two digits (0 to 23)

hh Hour in two digits (00 to 23)

n Minute in one or two digits (0 to 59)

nn Minute in two digits (00 to 59)

s Second in one or two digits (0 to 59)

ss Second in two digits (00 to 59)

ttttt Same as the Long Time predefined format

AM/PM Twelve-hour clock with the uppercase letters "AM" or "PM"

am/pm Twelve-hour clock with the lowercase letters "am" or "pm"

A/P Twelve-hour clock with the uppercase letter "A" or "P"

a/p Twelve-hour clock with the lowercase letter "a" or "p"

AMPM Twelve-hour clock with the morning/afternoon designator as defined by Regional 
Settings Properties in the Control Panel
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Use the following symbols to format Number and Currency fields:

Note: Use the DecimalPlaces property to override the default number of decimal places for 
the predefined format specified for the Format property, if desired.

Custom number formats can have one to four sections with semicolons (;) as the list separator. 
Each section contains the format specification for a different type of number, including.

For example, you could use the following custom Currency format:

Note: Using multiple sections without specifying a format for each section causes entries 
with no format to either display nothing or default to the formatting of the first section.

Text and Memo Data Format
Use the following symbols to format Text and Memo fields:

Symbol Description

. (period) Decimal separator. Defined by Regional Settings Properties in the Control Panel

, (comma) Thousand separator

0 Digit placeholder. Display a digit or 0

# Digit placeholder. Display a digit or nothing

$ Display the literal character "$"

% Percentage. The value is multiplied by 100 and a percent sign is appended

E– or e– Scientific notation with a minus sign (–) next to negative exponents and nothing 
next to positive exponents. This symbol must be used with other symbols, as in 
0.00E–00 or 0.00E00.

E+ or e+ Scientific notation with a minus sign next to negative exponents and a plus sign 
(+) next to positive exponents. This symbol must be used with other symbols, as 
in 0.00E+00.

Section Format Description

First positive numbers

Second negative numbers

Third zero values

Fourth null values

Format Setting Description

$#,##0.00[Green];($#,##0.00)[Red];"Zero";"Null" contains four sections sepa-
rated by semicolons and 
uses a different format for 
each section

Symbol Description
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Customized Text and Memo fields can have up to two sections. Each section contains format 
specifications for different data in a field, including:

For example, if you have a text box control in which you want the word "None" to appear when 
there is no string in the field, you could type the custom format @;"None" as the Format property 
setting. The @ symbol causes the text from the field to be displayed; the second section causes 
the word "None" to appear when there is a zero-length string or Null value in the field. As a result:

Yes/No Data Format
Format options are not available with the Yes/No data type. The field is displayed as a checkbox.

Mass Change Functionality
Mass change functionality can be used to reduce data entry by making changes to multiple items 
or components on a bill of material based on specified mass change criteria.

While using the mass change functionality, you may want to add or change the Mass Change 
column layout. See the Customized Column Layout section for more information on column layout.

Mass Change Types
Mass change functionality allows the user to specify different types of mass change processing. 
Mass change types include the following:

@ Text character (either a character or a space) is required.

& Text character is not required.

< Force all characters to lowercase.

> Force all characters to uppercase.

Section Description

First Format for fields with text.

Second Format for fields with zero-length strings and Null values.

Format Setting Display Result

>;@;”<None>” all data is uppercase and <None> where no data 
exists

Type Description

change changes item attributes or component detail

delete deletes a component from a bill of material

add adds a component to a bill of material

transition changes a component's revision levels based on effectivity 
dates

skip skips the record during processing
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Example: Change Item Attributes
Example: The person assigned as Buyer AAA is no longer with the company. All items with Buyer 
AAA must be changed to Buyer BBB.

1. Go to the Production Item Master.

2. Click the Filter By option. 

- Enter Buyer = AAA to filter the Item Master.

- Press ENTER.

3. Each item displayed has Buyer AAA assigned. Select all the item records. 

4. From the Edit menu, select Mass Change. The Mass Change dialog opens and each item 
that has Buyer AAA assigned is listed.

5. Position your cursor on the first item in the list:

- Enter Change Type = Change

- Enter Buyer = BBB

- Press ENTER.

6. From the Edit menu, select Copy to all records to copy the change information to each item 
in the Mass Change dialog.

7. Click Apply to start the mass change process.

8. Close the Mass Change dialog. 

9. From the View menu, select Refresh to review the changes.

Example: Add Components
Example: It is determined by the engineering team that a capacitor component requires insulation, 
and therefore an additional insulation component must be added to every bill of material that 
includes the capacitor item. 

1. Go to the Where Used or the Multi-Level Where Used.

2. Enter the capacitor component. Press ENTER. 

3. Each item displayed includes the capacitor component. Select all the item records. 

4. From the Edit menu, select Mass Change. The Mass Change dialog opens and the selected 
items are listed.

5. Position your cursor on the first item in the list:

- Enter Change Type = Add.

- Enter Component = Insulation

- Enter Pt Use and Seqn = as desired

- Enter CT (component type) = N (normal)

- Enter QT (quantity type) = I (per item)

- Enter In Effect and Out Effect as desired.

- Press ENTER. 

The change status is now Pending.

6. From the Edit menu, select Copy to all records.

7. Click Apply to start the mass change process.
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8. Close the Mass Change dialog. 

9. Go to the Bill of Material or Multi-Level Bill to view the changes.

Example: Change Components
Example: It is determined by the engineering team that Capacitor 1 and Capacitor 2 should both 
be replaced with Capacitor 3. 

1. Go to the Where Used or the Multi-Level Where Used.

2. Enter the Capacitor 1 component. Press ENTER. 

3. Each item displayed includes the Capacitor 1 component. Select all the item records. 

4. From the Edit menu, select Mass Change. Each parent that includes Capacitor 1 is listed.

5. Click Close to close the Mass Change dialog.

6. Enter the Capacitor 2 component. Press ENTER.

7. Each item displayed includes the Capacitor 2 component. Select all the item records. 

8. From the Edit menu, select Mass Change. The Mass Change dialog opens. The parent 
records that include Capacitor 2 are added to the list of parent records that include Capacitor 
1.

9. Position your cursor on the first item in the list:

- Enter Change Type = Change

- Enter Component = Capacitor 3

- Press ENTER.

10. From the Edit menu, select Copy to all records to copy the change information to each item 
in the Mass Change dialog.

11. Click Apply to start the mass change process.

12. Close the Mass Change dialog. 

13. Go to the Bill of Material or the Multi-Level Bill to view the changes.

Example: Delete Components
Example: It is determined by the engineering team that the diode component must be deleted from 
every bill of material.

1. Go to the Where Used or Multi-Level Where Used.

2. Enter the diode component. Press ENTER. 

3. Each item displayed includes the diode component. Select all the item records. 

4. From the Edit menu, select Mass Change. The Mass Change dialog opens and the selected 
items are listed.

5. Position your cursor on the first item in the list:

- Enter Change Type = Delete.

- Enter Component = Diode

- Press ENTER.

6. From the Edit menu, select Copy to all records.

7. Click Apply to start the mass change process.

8. Close the Mass Change dialog. 
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9. Go to the Bill of Material or Multi-Level Bill to view the changes.

Example: Transition Components
Example: It is determined by the engineering team that Capacitor 3 will be replaced with Capacitor 
4 on July 1st, 2001.

1. Go to the Where Used or Multi-Level Where Used.

2. Enter the Capacitor 3 component. Press ENTER. 

3. Each item displayed includes the Capacitor 3 component. Select all the item records. 

4. From the Edit menu, select Mass Change. The Mass Change dialog opens and each parent 
that includes Capacitor 3 is listed.

5. Position your cursor on the first item in the list:

- Enter Change Type = Transition.

- Enter Component = Capacitor 4

- Enter In Effectivity = July 1

- Press ENTER.

6. From the Edit menu, select Copy to all records.

7. Click Apply to start the mass change process.

8. Close the Mass Change dialog. 

9. Go to the Bill of Material or Multi-Level Bill to view the changes.

Revision History
Revision history functionality allows you to track revisions to bills of material by reviewing the 
sequence of changes, reviewing components at a revision level and printing the "in effect" revision 
level on the picklist. Revisions to bills of material are often called an ECR (Engineering Change 
Request) or ECN (Engineering Change Notice). See "Revision History" in the Manufacturing 
Analysis manual.

Using the Sample Product Release Rules
The Engineering Module includes sample product release rule definitions that are automatically 
installed and available with your system. Sample rule definitions are available for both levels of 
rules: 

• Phase 1 to Phase 2 (engineering to pre-production)

• Phase 2 to Phase 3 (pre-production to production)

Sample data includes pre-defined selection and edit conditions and rule definitions, which are 
rules with assigned conditions.

Sample Rule Definitions
Product release managers can use the sample database as a reference or starting point when 
creating new conditions and rules.

For example, you could start with the following sample information to set up your own company-
specific rule definitions:

Condition Field Relationship Value

Cost is Greater than 50 Cost is greater than 50
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A condition becomes a rule when it is applied to a release level, such as Engineering to Pre-
Production or Prep-Production to Production.

Using the Sample Workflow Database
The Engineering Module includes a sample workflow database that is automatically installed and 
available with your system. Sample data includes pre-defined users, groups, activities, documents 
and routings. The sample database also includes a set of pre-defined workflow assignments, such 
as users assigned to groups, groups assigned to activities, activities assigned to routings and 
documents assigned to routings.

Sample Database Examples
Workflow administrators can use the sample database as a reference or starting point when 
creating new workflow processes.

For example, administrators could start with the following sample database information to set up 
their own company-specific workflows:

Document Template Examples
Template documents can be copied and edited to include company-specific impact analysis 
information. For example, workflow administrators could open a document template and save it 
into a different directory. Company-specific impact analysis information can then be entered into 
the document. The company-specific documents are then available to be attached to a process. 

Document templates are located in the MFGSYS\ENGM\ECR_DOCS directory. Document 
templates are available for various impact analysis, including purchase orders, customer orders, 
WIP, process overview, inventory and fast tracks.

Workflow Using Electronic Mail
Workflow management takes advantage of electronic mail to communicate information and enable 
users to review as well as approve or reject processes. This electronic communication provides a 
quicker and easier method for completing a process. A MAPI-compliant electronic mail system is 
required.

Preparing Your Electronic Mail System
Your MAPI-compliant electronic mail system must be configured so that workflow administrators 
and users can send and receive electronic mail notifications. If you use an electronic mail system 
for workflow, contact your electronic mail system administrator to set up your workflow 
administrator and users. For example, in a Microsoft Exchange mail system, the following must be 
prepared:

• Workflow Administrators. Workflow administrators must be configured with the following:

Cost is not null Cost is not null

CT is equal to N CT is equal to N

Description is not blank Description is not blank 

User Group Activity Routing Template

Manager, MAA Operations Man-
agement

Impact Analysis Safety Change

Lawyer, LAA Legal Legal Review New Product Release
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- Personal Folder. A personal folder must be created.

- Delivery Option. The delivery option must be set to “personal folders.” The delivery 
option determines if the administrator can send electronic mail notifications.

• Users. Users involved in workflow must have a valid mail identifier defined in the company's 
electronic mail system.

Setting Up Mail Identifiers
The Engineering Module includes the ability to set up internal and external users with mail 
identifiers so that users can send and receive electronic mail notifications. Electronic mail 
identifiers must be set up for all users involved in workflow, including the following:

• Internal Users. Internal users are typically individuals who work within your company and 
have a mail identifier defined in your electronic mail system. Each internal user must have a 
Mail Id assigned in order to send or receive mail notifications. A Mail Id is your user 
identification, or alias, as defined in your electronic mail system. For example, in Microsoft 
Exchange, a Mail Id is your “display name”, such as John Smith.

• External Users. External users are typically individuals who work outside of your company 
and have a MAPI-compliant electronic mail post office address or an Internet address outside 
of your company’s mail system. Each external user must have a Mail Id and Mail Address 
assigned in order to send or receive mail notifications. A Mail Id can be user-defined and is 
used as a display name. A Mail Address is your fully qualified mail post office address 
identification as defined in your mail system. For example, a mail address can look similar to 
SMTP:AAA@my_company.com.

A Mail Id must be defined in order for the user to send or receive electronic mail notifications. 
Electronic mail notifications are not sent to users with missing or invalid mail identifiers. If all users 
in a group being notified have missing or invalid mail identifiers, you are prompted to enter a valid 
Mail Id.

ENGM will process Mail ID and Mail Address as follows:

Sending and Receiving Mail Notifications
The Engineering Module includes the ability to send and receive electronic mail notifications 
during the workflow process. The notification process includes the following:

• Send Starting Notifications. When a routing activity is ready to begin, the process can start. 
The workflow administrator uses the Start Process option to activate the process, which then 
sends electronic mail notifications to all users assigned to the groups that are associated with 
the activity.

• Receive Starting Notifications. Each user associated with the activity receives an electronic 
mail notification that the process has started. Notification information includes the process 
number, process title, activity title and a startup message. Startup message examples include 

Fill WKFL ECRA Action

Mail ID Mail Address Send to: Display as:

John Smith John.Smith@Infor.com John.Smith@Infor.com John Smith

Null John.Smith@Infor.com John.Smith@Infor.com John.Smith@Infor.com

John Smith Null Cannot send mail

Null Null Cannot send mail
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“This activity requires your disposition.” or “This activity has started but does not require your 
disposition.”

• Notify Groups. After the process has started, the administrator can use the Notify Groups 
option to send outstanding notifications to all users associated with the process activities. 
Outstanding notifications can include start process messages, final ending notifications or 
pending messages.

• Receive Ending Notifications. Each user associated with an activity receives an electronic 
mail notification when the process disposition, either approved or rejected, is final. Notification 
information includes the process Number, process title and an advisory message. Advisory 
message examples include “This process has been approved” or “This process has been 
rejected.”

Workflow Disposition Information
Workflow Management tracks various information during the disposition process, including the 
current status level and process comments.

Workflow Status Levels
Several types of statuses are tracked throughout the workflow process. Status types include the 
following:

User Status

Group Status

Activity Status

Status Description

not started Disposition process has not yet begun for the activity.

in process Disposition process has begun for the activity.

approved User has approved the process.

rejected User has not approved the process.

Status Description

not started Disposition process has not yet begun for the activity.

in process Disposition process has begun for the activity.

approved All users associated with the group have approved the pro-
cess.

rejected At least one user associated with the group has rejected pro-
cess.

Status Description

not started Disposition process has not yet begun for the activity.

in process Disposition process has begun for the activity.
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Process Status

Workflow Process Comments
Several types of comments can be entered into the system during the routing and disposition of a 
process. Comments are part of processing history and cannot be deleted after they are entered.

• General Process Comments. General process comments can be entered anytime during the 
routing and disposition but they are not attached to a specific process and are not included in 
the comments summary. General process comments can be used to explain ideas or thoughts 
that are not directly related to a process. 

- To add a general process comment to a process, click the right mouse button and 
select the New Comment option.

• Disposition Comments. Disposition comments can only be entered during the disposition 
when the user is either approving or rejecting a process. Disposition comments are included in 
the process comments summary. Disposition comments can be used to explain why the user 
is approving or rejecting the process. 

- To add a disposition comment, click the right mouse button and select Set Disposition, 
then enter your comments.

Engineering Module Database Architecture
The Engineering Module updates both production and engineering information. Production 
information is subject to the same edits (or business rules) as when entering data through 
the traditional user interface.

The ENGM data is stored in tables in the production database. The Engineering Module 
database architecture looks similar to the following:

approved All groups associated with the activity have approved the pro-
cess.

rejected At least one group associated with the activity has rejected the 
process.

Status Description

composition The process has been created and the process number has 
been assigned, but the process has not been routed.

in process The process is currently being routed to the appropriate 
reviewers for analysis and disposition.

Complete Analysis on the process is complete and all dispositions, either 
approved or rejected, for the process have been entered.
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Navigation and Selection Options
Several methods are available for navigating and selecting within the Engineering Module. 
Navigational and selection methods include the following:

• Menu Options. Use the mouse to select an option from a menu. Click the menu title to view 
the options for each menu. Menu options may not always be available. If an option is 
unavailable, the text is grayed and the option cannot be selected. Click on the menu option to 
start the action listed. 

• Toolbar Buttons. Use the mouse to select a button from the main toolbar. The toolbar 
provides a quick way to access some of the most frequently used features of the module. 

• Mouse Conventions. Use the mouse to “drag and drop” components from one category to 
another. For example, to add a user to a group, simply select the user and then drag and drop 
the user into the specified group. Click the left or right mouse buttons to select open menus 
and options.

• Keyboard Conventions. You can use the standard keyboard keys to navigate within the 
system. Keyboard conventions are key or key combinations that allow you to carry out a 
command or action.

Menu Options
Item Master and Bills of Material

Menu Option Description

File Open Opens based on specified information.

Copy Bill of 
Material

Opens the Copy Bill of Material dialog, where you set options for copying a 
bill of material.

Go to Frame Allows navigation to the frames available in the Product Definition applica-
tion.

Print Preview Displays a report available for the specified parent item.

Quick Print Displays record selection options available to print an ad-hoc report.

Save Settings Saves all option settings for the application. If you close an application 
without saving the settings and you have not selected the Save Settings on 
Exit option on the Options menu, you lose all settings changes you did not 
save previously.

Production
tables

Engineering
tables

Engineering
business rules Fourth Shift business rules

ITMB BILLENGM
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Exit Exits you from the application.

Edit Find Opens the Find application which allows you to search for a specific com-
ponent or reference designator, based on search criteria.

Find Next Repeats the search using the criteria defined in the Find feature.

Mass Change Opens the Mass Change dialog which allows you to change items based 
on where used specifications.

Select All 
Records

Selects all records for the current parent item.

Copy Refer-
ence Designa-
tors

Copies selected text to the Clipboard. Text that you copy to the Clipboard 
replaces the previous contents.

Paste Refer-
ence Designa-
tors

Inserts a copy of the Clipboard contents at the insertion point, replacing the 
selection (if any) with the text on the Clipboard. This command is not avail-
able if the Clipboard is empty or if the selected text cannot be replaced.

Promote Item Allows you to promote an item from one release level to the next release 
level.

Delete Removes the text from the field; the text is not available for future use.

Add New 
Record

Creates a new record.

Add Ref Des Opens the Ref Des field from the Ref Des Entry tab which allows you to 
enter reference designators.

Create Ref Des 
Range

Allows you to enter a range of reference designators.

Zoom Expands the viewing capacity of the selected information.

Validate Excep-
tion Records

Validates any item on a bill of material which does not have an associated 
parent item.

Set Exclusions Allows you to enter a bill of material filter based on component type related 
criteria.

Apply Exclu-
sions

Applies any predefined filters and displays the filtered bill of material.

Remove Exclu-
sions

Removes any filters and displays the entire bill of material.

Columns Allows you to specify column layout

View Refresh Clears the active field.

Graphical Bill 
of Material

Opens the Graphical Bill of Material dialog which allows you to view the bill 
of material in a graphical hierarchy.

Shop Calendar Opens the Shop Calendar, which allows you to calculate shop days based 
on specified criteria and view embedded revision information.

Production 
Item Finder

Opens the Production Item Finder, which allows you to search for an item.

Engineering 
Item Finder

Opens the Engineering Item Finder, which allows you to search for an item.

Copy Buffer Stores selected text. 
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Clear Criteria Clears data from the current field.

Options Allows you to specify general layout, reference designator and lead time 
options.

Help Help Topics Opens the help.

Setting Up the 
Module

Opens the help manual at the Setting Up the Module section.

About ENGM Displays information about the release level and name of the application.

Pop-up Cut Removes the selected text and puts it on the Clipboard. Text that you place 
on the Clipboard remains there until you replace it with a new item.

Expand All 
Levels

Expands the current bill of material level down to all lower levels of each 
component or subassembly.

Undo Reverses your previous action.

Menu Option Description

File Open Data-
base

Opens the engineering database.

Close Data-
base

Closes the engineering database.

Repair/Com-
pact Database

Displays options to select the engineering or Workflow database to begin 
the process of repairing or compacting.

Analyze Eng/
Prod Data-
bases

Analyzes the integrity between the engineering and production databases 
and displays the results in a log file.

Delete Data-
base Mainte-
nance Log

Deletes the log file that is produced during database maintenance tasks.

Save all 
changes

Saves all changes made to the user-defined fields.

Exit Exits you from the application.

Edit Copy Copies selected text to the Clipboard. Text that you copy to the Clipboard 
replaces the previous contents.

Paste Inserts a copy of the Clipboard contents at the insertion point, replacing the 
selection (if any) with the text on the Clipboard. This command is not avail-
able if the Clipboard is empty or if the selected text cannot be replaced.

Delete Removes the text from the field; the text is not available for future use.

New Field Creates a new field.

Rename Field Renames a field.

Undelete Field Undeletes a field.

Revert to Origi-
nal Values

Restores original values into fields.
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View Toolbar Toggles the display of the toolbar.

Status bar Toggles the display the status bar.

User-Defined 
Fields

Moves to the User Defined Fields tab.

Database 
Maintenance

Moves to the Database Maintenance tab.

Arrange Icons Displays sort options, such as by name, caption, type or required.

Refresh Clears the active field.

Help Help Topics Opens the help.

Setting Up the 
Module

Opens the help at the Setting Up the Module section.

About Engi-
neering

Displays information about the release level and name of the application.

Menu Option Description

File Open Data-
base

Opens the engineering database.

Close Data-
base

Closes the engineering database.

Exit Exits you from the application.

Edit Modify Phase 
Names

Allows you to customize the names of the release level phases.

New Creates a new condition or rule based on the area selected.

Rename Renames a condition or rule based on the area selected.

Delete Deletes a condition or rule based on the area selected.

Properties Displays the current properties.

View Tool bar Toggles the display of the toolbar.

Status bar Toggles the display of the status bar.

Engineering to 
Pre-Production

Displays conditions and rules for this release level.

Pre-Produc-
tion to Produc-
tion

Displays conditions and rules for this release level.

Refresh Redisplays the view based on changes, if any.

Help Help Topics Opens the help.

Setting Up the 
Module

Opens the help at the Setting Up the Module section.
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Process Status and Disposition
You can use either ECRA or ECRD to view process status and disposition information, but the 
administrator tasks can only be done using ECRA. Several menu options vary between ECRA and 
ECRD.

About Product 
Release Man-
agement

Displays information about the release level and name of the application.

Menu Option Description

File New Creates a new process.

Delete Deletes an existing process.

Properties Displays the current properties.

Exit Exits you from the application.

View Processes 
Awaiting Action 
by xxx

Display all processes assigned to a specific user id using the id for the user 
currently logged onto the system.

Show all Pro-
cesses

Displays all processes that exist in the system.

Edit Views Allows view options to be specified and saved.

Refresh View Redisplays the view based on option changes, if any.

Admin Processes 
Awaiting Notifi-
cation

Display all processes awaiting notification.

Late Processes Display all processes in the system that are later than the Date Started + 
Allowed Days to Disposition.

Notify Groups Send notification to all the groups that the process has started.

Start Process Begin the routing of a process.

Help Help Topics Opens the help.

Setting Up the 
Module

Opens the help at the Setting Up the Module section.

About Process 
Status and Dis-
position

Displays information about the release level and name of the application.

Pop-up New Creates a new comment or document based on area selected.

Display Displays the selected comment or document based on area selected.

Set Disposition Allows you to approve or reject a process.

Status Displays the current status.
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Toolbar Buttons
The main toolbar is located below the menu bar at the top of the application window. The toolbar 
provides a quick way to access some of the most frequently used features. Toolbar buttons may 
vary based on available features and for inquiry-only features. 

Item Master and Bills of Material

Menu Option Description

File New Creates a new user, group, activity, document or routing template based on 
area selected.

Delete Deletes an existing user, group, activity, document or routing template 
based on area selected.

Exit Exits you from the application.

Edit Include Includes the selected user, group or activity into the selected topic.

Remove Removes the selected user, group or activity from the selected topic.

View Refresh Data Redisplays the view based on option changes, if any.

Groups View the Groups tab.

Activities View the Activities tab.

Routing Tem-
plates

View the Routing Templates tab.

Properties Displays the current properties based on area selected.

Help Help Topics Opens the help.

Setting Up the 
Module

Opens the help at the Setting Up the Module section.

About Work-
flow Setup

Displays information about the release level and name of the application.

Pop-up Move Down Move the activity down one position in the list, which determines the order 
activities are performed.

Move Up Move the activity up one position in the list, which determines the order 
activities are performed.

Toolbar Options Description

Go to Frame Allows navigation to the frames available in the Product Definition application

Open Opens based on specified information.

Save Data Saves the current data.

Print Preview Generates a report based on the current column settings and displays report on 
screen for review. Print the generated reports using your standard Windows print-
ing procedures.

Quick Print Displays record selection options available to print an ad-hoc report.
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Product Release Rule Definitions

Copy Reference Des-
ignators

Copies selected text to the Clipboard. Text that you copy to the Clipboard 
replaces the previous contents.

Paste Reference Des-
ignators

Inserts a copy of the Clipboard contents at the insertion point, replacing the 
selection (if any) with the text on the Clipboard. This command is not available if 
the Clipboard is empty or if the selected text cannot be replaced.

Promote Item Allows you to promote an item from one release level to the next release level.

Find Opens the Find application which allows you to search for specific information in 
the displayed list.

Graphical Bill of Mate-
rial

Opens the Graphical Bill of Material dialog which allows you to view the bill of 
material in a graphical hierarchy.

Shop Calendar Opens the Shop Calendar, which allows you to calculate shop days based on 
specified criteria and view embedded revision information.

View Allows you to select a previously specified view using a drop menu

Save Current View Saves the current layout of fields into a view.

Refresh Clears the active field.

Set Exclusions Allows you to enter a filter based on item type related criteria.

Apply Exclusions Allows you to filter records based on specified criteria.

Last Message Displays the previous message that was in the Status Bar, which is located at the 
bottom of the form.

Help Displays the contents of the help.

Toolbar Options Description

Save Saves all changes made to the user-defined fields.

Copy Copies selected text to the Clipboard. Text that you copy to the Clipboard 
replaces the previous contents.

Paste Inserts a copy of the Clipboard contents at the insertion point, replacing the 
selection (if any) with the text on the Clipboard. This command is not available if 
the Clipboard is empty or if the selected text cannot be replaced.

Delete Removes the text from the field; the text is not available for future use.

New Field Creates a new field.

Help Displays the contents of the manual.

Toolbar Options Description

New Condition Allows you to create a new condition.

New Rule Allows you to create a new rule.

Properties Displays the properties of the selected condition.
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Keyboard Conventions
The Engineering Module has the ability to use the keyboard to transport you through the system. 
Keyboard conventions are a key or key combination that allows you to carry out a command or 
action. The Engineering Module uses the standard Microsoft Windows key conventions. For 
example, press CTRL + C to copy information to the Clipboard. See your Microsoft Windows 
User's Guide for more information on the standard Microsoft Windows key conventions. 

Function Keys and Other Keyboard Options
The following function keys are defined for the Engineering Module:

View Allows you to select a previously specified view using a drop menu

Help Displays the contents of the manual.

Toolbar Options Description

All Processes Display all processes that exist in the system.

Processes Awaiting 
Action by xxx

Display all processes assigned to a specific user id using the id for the user cur-
rently logged onto the system.

Late Processes Display all processes in the system that are later than the Date Started + Allowed 
Days to Disposition.

Processes Awaiting 
Notification

Display all processes awaiting notification.

Approve/ Reject Pro-
cess

Allows you to approve or reject a process.

Start Process Begin the routing of the process.

Notify Groups Send notification to all the groups that the process as started. 

View Allows you to select a previously specified view using a drop menu

Help Displays the contents of the manual.

Function Key Description

F1 Displays the manual.

F3 Finds the next value that matches the criteria entered in the Find feature.

F5 Refreshes the screen data.

ESC From the Parent field, restores previous parent item.
From the Component Effectivity Date field, restores the current date.
Cancels a view of information while it is being loaded.

CTRL+F Opens the Find feature.

CTRL+END Finds the last item in the list.

CTRL+HOME Finds the first item in the list.

CTRL+ENTER Creates a new line while entering engineering information in the Text field.
Engineering 38



Fourth Shift Release 8.00 Setting Up the Engineering Module
Accelerator Keys
Accelerator keys are keyboard shortcuts that are available for menu options and buttons. The 
accelerator key available is the combination of the ALT key and: 

• the underlined letter on the button

• the underlined letter in the menu title, then the underlined option from the menu. For example, 
press ALT+B, then press C to open the Customer application. This combination is represented 
by ALT+B, C when referenced in documentation.

Using the Finder
The Finder is used to locate records, such as items or components, in the database. The Finder 
displays all records that match the known search criteria you supply.

The Finder is made up of two grids: the Search criteria grid and the Results list grid.

Using the Search Criteria Grid
The Finder allows you to search for records or values that meet a set of defined search criteria. 
By entering known field values, you can locate a record and open it for review or modification. 

You can:

• Locate a record by a known value. For example, you can use the Finder to locate an item by 
entering the item's id. In this case, the Item you enter is the search criteria.

• Locate a record by an incomplete value. If you know the first three characters of an Item, 
for example, you can enter them as the search criteria. The Finder displays a list of all of the 
available items whose Item begins with those three characters.

• Locate a record using values for multiple fields. If you know part of an item's description in 
addition to the first three characters of the Item, you can enter information for both the Item 
and Description. The Finder displays a list of all of the available items whose Item begins with 
those three characters and includes the partial description. It is important to note that the 
Finder locates records that meet both criteria, not either criteria.

• Locate a record using a wildcard character. If you know part of an item's description in 
addition to part of the Item identifier, you can enter a wildcard for both the Item and 
Description. Use the "*" wildcard character in addition to the partial item and description. 

For example, if you want to search for components where the item identifier contains the word 
front and the description includes the word wheel, enter *front* for the partial Item and *wheel* for 
the partial Description. The Finder displays a list of all the available items whose Item and 
Description match the partial descriptions.

The Finder displays key fields, such as Item, in bold. Using key fields in search criteria significantly 
improves the searching performance. As a general rule, the more specific your search criteria, the 
easier it will be to locate the record you are looking for.

Query by Example
The Finder uses a method called query by example, or QBE. This method allows you to request 
information from a database in a natural and intuitive way.

When the Finder opens, the Search criteria grid contains columns that represent fields. The fields 
that are displayed depend on the type of record you are looking for. For example, if the Finder is 
helping you locate an item, you will see columns for fields like Item Id, UM and Description. 

ALT+F4 Exits you from the application.
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Using query by example, enter the information about the record you are searching for in the 
appropriate column or columns. When you press ENTER, the Finder displays a list of the records 
that meet all of the search criteria specified.

Using the Results List Grid
The Results list grid displays the records that match the search criteria. Each record appears in a 
row in the Results list grid.

The Results list grid contains the same columns that appear in the Search criteria grid. When it 
displays the records that meet the search criteria, it displays values in all of the available columns. 
The number of records displayed in the Results list depends on how specific the search criteria is.

Opening a Record
Once you have located the record you want to modify or review, you can open it in the appropriate 
application. Select the record by clicking anywhere on the row. 

When the record is selected, the row marker appears to the left of the first column in the grid. To 
open the selected record in the application, simply double click the selected row into the Parent 
field of the application.

Keeping the Finder Open
When you open a record from the Finder, the Finder window remains open. You can toggle 
between the Finder and other applications at any time.

If you have used the Finder to locate a group of records that meet certain search criteria, the list 
remains available to you in the Results list. This is useful if you have modifications to make to a 
group of records. For example, you can change the reference designators for items within a range 
of Item Ids. Use the Finder to locate the list of items by Item Id, then open and modify each as 
needed.

You can close the Finder by choosing Close from the File menu. When you close the Finder, the 
information in the Results list is cleared and reset for the next use.

Using the Graphical Features
The Engineering Module includes graphical hierarchy displays to display information, such as 
multi-level bills of material or workflows and processes. 

Standard Graphical Features
The standard graphical features include the following:

• uses the standard Microsoft Windows Explorer features, such as using the "+" and "-" keys to 
open or close a level

• the "*" key on the numeric keypad can also be used to expand all levels of the graphical 
display

• for the bills of material, unique icons are used to represent each component type, such as 
normal, phantom or resource

• for the workflows, unique icons are used to represent the different processes, such as user, 
group, activity or process

Color Coded Icons
In the Workflow Management application, icons are color coded to represent various levels of the 
process and disposition, such as:

Icon Color Description

Black process not started; contents can be changed 
Engineering 40



Fourth Shift Release 8.00 Setting Up the Engineering Module
Generating Reports
Several reports are generated by the Engineering Module. These reports are based on Crystal 
Reports Professional predefined templates and use ODBC links to access item and bill of material 
information.

The Engineering Module also includes quick print reports and the ability to customize reports.

Quick Print Reports
Quick Print is provided to create printed reports for ad-hoc views of data such as for any user-
defined table column sorting or layout customizations. Quick Print includes:

• available from the Bills of Material, Item Master, Item History, Item Finder, and Lead Time 
(graphical display) views

• accessed by choosing the Quick Print option from the File menu or by clicking the Quick Print 
toolbar button

• ability to select options for record selection and page setup

• ability to press ESC to interrupt or cancel the quick print

If you create custom views of data that are used repetitively, you may find it convenient to create 
custom reports and associate them with your views. It is recommended that you create your 
custom reports based on supplied report templates and then modifying them as necessary using 
Crystal Reports Professional. Crystal Reports Professional is the industry standard report writer 
and must be purchased separately.

Customized Reports
Customized reports can be associated with local or global views if one has previously been 
created using Crystal Reports. Customized reports are associated with a view using the Save 
Current View toolbar button. If a customized report is not assigned, the standard report is used.

To customize a standard report template provided with the Engineering Module, you need to use 
the Crystal Reports Professional software package, which must be purchased and installed 
separately. It is recommended that you do not modify the standard report template without 
renaming the file. Future updates to the Fourth Shift software overwrite the standard report 
template. Use the following steps to modify the report templates:

Modifying Report Templates
1. Copy the standard report template to another filename.

2. Use Crystal Reports Professional to customize the new report.

3. Save the new report.

4. Attach the customized report to a local or global view using the Save Current View toolbar 
button.

Yellow process started; contents of activity cannot be changed

Red process is rejected

Green process is approved

Gray information only, no action required
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Tables Names
The Engineering module uses different table names.

Access Table Names SQL Table Names

DBVersionInfo n/a

DefinedConditions FS_ItemPromotionCondition

DefinedPhases FS_ItemPromotionPhase

DefinedRules FS_ItemPromotionRule

ENG_BOM FS_EngineeringBillOfMaterial

ENG_ITEM FS_EngineeringItem

LinkedPhaseRules FS_ItemPromotionPhaseRuleLink

LinkedRuleEdits FS_ItemPromotionRuleEditLink

LinkedRuleSelections FS_ItemPromotionRuleSelectionLink

REFDES FS_ReferenceDesignator

USERITEMS FS_EngineeringItemData

USERVIEWS1 FS_UserGrid

USERVIEWS2 FS_UserGridColumn

USERVIEWS3 FS_UserGridDefault

DefinedActivities FS_WorkflowActivity

DefinedDocuments FS_WorkflowDocumentTemplate

DefinedECRTypes FS_WorkflowRoutingTemplate

DefinedGroups FS_WorkflowGroup

DefinedUsers FS_WorkflowUser

ECRActivityStatus FS_WorkflowProcessData

ECRComments FS_WorkflowComment

ECRDescriptions FS_WorkflowProcess

ECRDocuments FS_WorkflowDocument

ECRGroupStatus FS_WorkflowGroupData

ECRUserStatus FS_WorkflowUserData

LinkedActivityGroups FS_WorkflowActivityGroupLink

LinkedECRTypeActivities FS_WorkflowRoutingTemplateActivityLink

LinkedECRTypeDocuments FS_WorkflowRoutingTemplateDocumentLink

LinkedGroupUsers FS_WorkflowGroupUserLink

UserViews FS_WorkflowProcessFilter
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System Administration
The System Administration manual outlines the tasks involved in maintaining the Fourth Shift 
system. The Engineering Module includes special considerations in the area of daily backups and 
security.

Configuration Variables
The following configuration variables are used in the Engineering Module and can be customized, 
if desired:

Daily Backups
The document template files in the MFGSYS\ENGM\ECR_DOCS directory and the process-
specific document files in the related subdirectories should be included in your daily backup. See 
Database Backups in the System Administration manual for more information on system backups.

Workflow Document Files
In a standard installation, the workflow document template files are located in the 
MFGSYS\ENGM\ECR_DOCS directory. The document template location is identified using the 
EngmDocDir configuration variable in the FS.CFG file.

These document template files are used as "placeholder" documents and can be attached to a 
process and then updated with company-specific information. When a document template file is 
attached to a process, the template file is copied to the process-specific location. The process-
specific directories are system-defined 8-numeric character names, similar to the following:

Variable Description

EngmDir Engineering database location

EngmDocDir Document template location

EngmPromoteOption1 Automatically assigns the Engineering item number as the target produc-
tion number when the engineering items are promoted into the Pre-Pro-
duction phase. Set variable to "True" to enable the capability or "False" to 
disable the capability.

EngmPromoteToExisting Allows an engineering item to be promoted to an existing production 
item, provided that the production item does not have a bill of material. 
Set variable to "True" to enable the capability or "False" to disable the 
capability.

EmbeddedRevPrefix Bill of material embedded revision level prefix. Default is “Rev” or value 
defined in the FS.CFG file.

WorkCenterDelimiter Delimiter used for workcenters. Default is “[“ (bracket). Valid delimiters 
include: [ - * . / + %

Directory Process-specific subdirectory

MFGSYS\ENGM\ECR_DOCS 00000001

00000002

00000003

00000004
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Security
Security rules for accessing the Engineering features should be assigned based on the 
requirements for each user. Use the PASS (Password Maintenance) screen to assign each user 
identifier a password and access code. Use the FCMT (Function Code Maintenance) screen to 
associate function codes with access codes.

Security Access Levels
Security access levels give system administrators the ability to allow or limit access to certain 
Engineering features, or function codes, based on the job requirements of the user. Security is 
based on the following access levels:

Security for the Engineering module is cumulative. When a user is assigned different access levels 
to the same feature, cumulative security provides the higher level (update) access even when the 
user is trying to use the feature with a lower level (inquiry) access. 

For example, if a user is assigned both inquiry (PBLI) and update (PBLL) access to the production 
bill of material, the user is allowed the update (PBLL) access, even when trying to use the 
production bill of material with inquiry (PBLI) access. 

Security by Function Code
Security is assigned to a user by function code on the PASS and FCMT screens.

Product Definition - Engineering

00000005

Level Description PASS Screen Examples

none user has no access none

inquiry user can only 
access in inquiry 
mode

PBLI, PITI, PMLB, PCMP, PWUS, PCMS, PSMB, 
PMWU, PCRL, EBLI, EITI, EMLB, ECMP, EWUS, 
ECMS, ESMB, EMWU, ECRL, ECRD

update user can access in 
update mode

PITB, PBLL, EITB, EBLL, EIMP, EDBA, WKFL, 
ECRA

FCMT for 
Inquiry

FCMT for 
Update Security Description

EITI EITB Item Master

EITB Allows user to manually promote an item (Item Status E to A) 
or manually add, change or delete linkages between engineer-
ing and production items. Default does not allow access.

EBLI EBLL Bill of Material

EBLL Allows use of the Copy Production Bill to Engineering Bill fea-
ture

ECP1 Allows use of the Copy Engineering Bill to Engineering Bill fea-
ture
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Product Definition - Production

Product Release Management

ELT1 Allows use of the Lead Time Analysis feature

ECMP Comparison Bill

EWUS Where Used

ECMS Comparison of Summarized Bills

ESMB Summarized Bill

EMLB Multi-Level Bill

EMWU Multi-Level Where Used

ECRL Multi-Level Costed Bill

EDBA Engineering Database Administration

EIMP Engineering Data Import

FCMT for 
Inquiry

FCMT for 
Update Security Description

PITI PITB Item Master

PBLI PBLL Bill of Material

PCP1 Allows use of the Copy Production Bill to Production Bill feature

PLT1 Allows use of the Lead Time Analysis feature

PCMP Comparison Bill

PWUS Where Used

PCMS Comparison of Summarized Bills

PSMB Summarized Bill

PMLB Multi-Level Bill

PMWU Multi-Level Where Used

PCRL Multi-Level Costed Bill

FCMT for 
Inquiry

FCMT for 
Update Security Description

PRRD Product Release Rule Definitions

EPR1 Allows user to promote items from Phase 1 to Phase 2.

EPR2 Allows user to promote items from Phase 1 to Phase 2 or from 
Phase 2 to Phase 3 without following any promotion rules.

PPR1 Allows user to promote items from Phase 2 to Phase 3.
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Workflow Management

Security to Disable Screens
We recommend that you use the FCMT screen to disable the following screens if you are using 
bills of material that include reference designators:

• ITMB (Item Master)

• BILL (Single Level Bill of Material)

• BILI (Single Level Bill of Material Inquiry)

• CBIL (Copy Bill of Material)

• MBIL (Multi-level Bill Inquiry)

• WUSE (Single Level Where Used Inquiry)

• MUSE (Multi-Level Where Used Inquiry)

Bills of material that include reference designators should only be maintained using the features 
available in the Engineering Module.

FCMT for 
Inquiry

FCMT for 
Update Description

ECRA Process Status and Disposition - Admin

ECRD Process Status and Disposition
(allows updates to user-specific processes and inquiry of other 
processes)

WKFL Routing Template Administration
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Engineering Data Import Setup
The Engineering Module includes data import functionality which is used to import data from 
external sources into the Engineering Module. For example, you may want to import engineering 
bills of material, reference designators or the linkages between engineering and production items. 
Manually entering this information can be time-consuming, but importing this information using the 
data import capability is quick and efficient. 

These import transactions allow you to quickly add engineering information, for example when 
adding information about a new product line or during implementation. Import transactions for item 
maintenance are not available using this feature.

The data from external sources is imported into the Engineering Module using an import file that is 
created by the user. The import file must conform to certain standards and rules in order for the 
data import process to be successful. 

If you wish to import data other than for the Engineering Module, see the Data Import Dictionary for 
detail on additional transactions.

Selecting an Editor to Create the File
The data file may be created with various editor programs, including the following:

• a file editor, such as Microsoft Word or Notepad, where you enter in the data and then save 
the data as "text only"

• a program such as Microsoft Excel or Access, where you enter the data into columns and then 
save the data as text with comma-separated values

If your system uses commas within field values, such as within the item or item description, you 
may want to verify that your data file includes double quotation marks around the strings. For 
example, the item description "19-inch frame, red" would need to be enclosed in double quotation 
marks in order to be successfully imported.

Import File Format Rules
The engineering data import file must be created using a specified format which includes a header 
record and data records in one of several available file layouts.

Import File Header Record
The data file that is imported into the engineering data base must include a header record that 
conforms to the following standards and rules:

• First Record. The header record must be the first non-blank or non-comment record in 
the file.

• Column Headings. The column headings must be entered exactly as documented in the 
Field Name column in the File Layout sections. For example, the Point of Use field must be 
entered into the header record as Pt_Use. 

If the column headings are not entered correctly into the data import file, the headings will be 
displayed in lower case in the Import Results area when the import data file is opened.

Import File Data Records
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The data records that are imported into the engineering data base must conforms to the following 
standards and rules:

• Field position. Column headings may be listed in any order in the header record. The fields in 
the subsequent records must be ordered according to the column heading order in the header 
record.

• Separator Values. Commas must be used to separate all field values in the data import file. It 
is recommended that strings be enclosed using double quotes in order to avoid errors during 
the import process. For example, the item description "19-inch frame, red" would not be 
successfully imported unless it was entered into the data file enclosed in double quotes.

• Ignored Records. Blank lines or comment records beginning with “#” or “;” are ignored 
by the import process.

Engineering Import File Layouts
Several file layouts are available for importing engineering data into the ENGM Module. 
Regardless of the file layout, each record in the import file must identify the complete set of fields 
required for the transaction to process. All empty fields listed must be included for the layout to be 
accepted by the import process. File layouts include the following:

Add Engineering Item
To add an engineering item to the engineering data base, it is recommended that the following 
field information be included in the import data file.

Example Data Record Layout
"Item","Item_Desc","UM","MB","Drwg","Rev",DPC,Price,Cost,"Prod_Item","Item_Type",Fixed_Lea
d_Time

File Layout Fields

Heading Description

Screen Name Field as it appears on the screen. 
Throughout the ENGM Module, engineering items have an 
asterisk (*) prefix in the field label.

Field Name Required title in the header record

Max Length Maximum length accepted for field

Type Data field type:
A = alphanumeric
D = date
N = numeric

Notes Lists if field is required and also includes default values

Screen Name Field Name
Max 

Length Type Notes

*Item Item 30 A Required

*Item Description Item_Desc 70 A Default: *
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(1) The Prod_Item field is used to associate the engineering item to a production item.

Add Components to an Engineering Bill
The following import information is required to add engineering or production components to an 
engineering bill.

Example Data Record Layout
"Parent","Component",“Prod_Component”,"Pt_Use","Seqn","Com_Typ”,Quantity,"Qty_Typ","In_Ef
fect","Out_Effect",
"In_Rev","Out_Rev",LT_Offset,Scrap_Pcnt,”Component_Source”

File Layout Fields

*UM UM 4 A

*MB MB 1 A Default: B

*Drwg Drwg 15 A

*Rev Rev 15 A

*Dec Pre Cd Dpc 1 N Default: 0
No decimal allowed.

*Price Price 10 N Default: 0
One decimal allowed.

*Cost Cost 10 N Default: 0
One decimal allowed.

Item Prod_Item (1) 15 A

*Item Type Item_Type 1 A Default: N

Fixed LT Fixed_Lead_Time 3 N Default: 0
No decimal allowed.

Screen Name Field Name
Max 

Length Type Notes

*Parent Parent 30 A Required

*Component or 
Component

Component or 
Prod_Component 
(1)

30 A Required

*Pt Use Pt_Use 5 A Default: 00000

*Seqn Seqn 3 A Default: 0
No decimal allowed.

*CT Com_Typ 1 A Required
Default: N

*Quantity Quantity 10 N Default: 1
One decimal allowed.

*Qty Type Qty_Type 1 A Default: I

*In Effect In_Effect D Default: 01/01/1980
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(1) Each record may import either an engineering component (*Component) or production 
component (Component) but not both.

(2) Include this field if you are adding a production component to an engineering bill. When the 
Component_Source field is specified, the Prod_Component field is ignored and therefore it is not 
required to be in the incoming data file.

Add Reference Designators to a Component
The following import information is required to add reference designators to an engineering or 
production component. Reference designators can be added to a component at the same time 
that the component is being added to the bill of material. In order to import both sets of information 
using one data import file, use the file layout for adding components to an engineering bill of 
material, and be sure to include the fields for adding the reference designators to the component.

Example Data Record Layout
"Parent","Component",“Prod_Component”,"Pt_Use",”Seqn”,"Com_Typ”,Quantity,"Qty_Typ","In_Ef
fect","Out_Effect",
"In_Rev","Out_Rev",LT_Offset,Scrap_Pcnt,”Parent_Source”,”Component_Source”,”RefDes”,”RD
_Tag”

File Layout Fields

*Out_Effect Out_Effect D Default: 12/31/2079

*In_Rev In_Rev 2 A

*Out Rev Out_Rev 2 A

*LT Offset LT_Offset 3 N Default: 0
No decimal allowed.

*Scrap Pcnt Scrap_Pcnt 3 N Default: 0
One decimal allowed.

(none) Component_Source 
(2)

1 A Values include:
0 – Production
1 – Engineering 
Default: 1

Screen Name Field Name
Max 

Length Type Notes

*Parent Parent 30 A Required

*Component or 
Component

Component or 
Prod_Component 
(1)

30 A Required

*Pt_Use Pt_Use 5 A Required 
Default: 00000

*Seqn Seqn 3 A Required 
Default: 0
No decimal allowed.

*CT Com_Typ 1 A Required 
Default: N
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(1) Each record may import either an engineering component (*Component) or production 
component (Component) but not both.

(2) Include Parent_Source = 0 if you are adding reference designators to a production parent.

(3) If the Component_Source field is not in the import file, the Prod_Component field is assumed to 
contain a production component and the Component field is assumed to contain an engineering 
component. When Component_Source = 0 is specified in the import file, the Prod_Component 
field is ignored and therefore it is not required to be in the incoming data file.

(4) This field may include multiple reference designators, which must be comma-delimited. 
Ranges are also supported, which must use a hyphen (-) as the range separator.

(5) The reference designator text included in this field will be applied to every reference designator 
entered in the RefDes field. To import unique text, a separate record must be created for each 
reference designator and its unique text entered into the RD_Tag field.

File Layout Examples
Use the following file layout examples to help understand import file format and layout structures. 

Add Engineering Item 19-REDe to Engineering database
"Item","Item_Desc","UM","MB","Drwg","Rev",DPC,Price,Cost,"Prod_Item","It
em_Type",Fixed_Lead_Time

*Quantity Quantity 10 N Default: 1
One decimal allowed

*Qty Type Qty_Type 1 A Default: I

*In Effect In_Effect D Default: 01/01/1980

*Out_Effect Out_Effect D Default: 12/31/2079

*In_Rev In_Rev 2 A

*Out Rev Out_Rev 2 A

*LT Offset LT_Offset 3 N Default: 0
No decimal allowed.

*Scrap Pcnt Scrap_Pcnt 3 N Default: 0
Decimal allowed.

(none) Parent_Source (2) 1 A Values include:
0 – Production 
1 – Engineering
Default: 1

(none) Component_Source 
(3)

1 A Values include:
0 – Production
1 – Engineering 
Default: 1

Reference Desig-
nators

RefDes (4) 10 A Required

Reference Desig-
nator Text

RD_Tag (5) 255 A
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"19-REDe","19-inch frame, red","EA","M","A12","A",0,55.25,30,"19-
RED","N",3

Add Engineering Component AT-100e to an Engineering Bill
"Parent","Component","Pt_Use","Seqn","Com_Typ",Quantity,"Qty_Typ","In_Ef
fect","Out_Effect","In_Rev",
"Out_Rev",LT_Offset,Scrap_Pcnt
"19-REDe","AT-100e","0010","001","N",2,"I","10/10/1999","12/31/
2079","A","B",1,2

Add Production Component AT-100 to an Engineering Bill
"Parent","Component","Pt_Use","Seqn","Com_Typ",Quantity,"Qty_Typ","In_Ef
fect","Out_Effect","In_Rev",
"Out_Rev",LT_Offset,Scrap_Pcnt,"Component_Source"
"19-REDe","AT-100","0010","001","N”,2,"I","10/10/1999","12/31/
2079","A","B",1,2,"0"

Add Reference Designators R1-R3 to an Engineering Component
"Parent","Component","Pt_Use","Seqn","Com_Typ",Quantity,"Qty_Typ","In_Ef
fect","Out_Effect","In_Rev",
"Out_Rev",LT_Offset,Scrap_Pcnt,"Parent_Source","RefDes","RD_Tag"
"19-REDe","AT-100e",“0010","001","N”,2,"I","10/10/1999","12/31/
2079","A","B",1,2,"1","R1-R3",""

Add Reference Designators R1-R3 to a Production Component
"Parent","Component","Pt_Use","Seqn","Com_Typ",Quantity,"Qty_Typ","In_Ef
fect","Out_Effect","In_Rev",
"Out_Rev",LT_Offset,Scrap_Pcnt,"Parent_Source","Component_Source","RefDe
s","RD_Tag"
"19-REDe","AT-100","0010","001","N”,2,"I","10/10/1999","12/31/
2079","A","B",1,2,"0","0","R1-R3",""

Add Reference Designators R4-R6 to a Production Component using 
Prod_Component Field
"Parent","Prod_Component","Pt_Use","Seqn","Com_Typ",Quantity,"Qty_Typ","
In_Effect","Out_Effect","In_Rev",
"Out_Rev",LT_Offset,Scrap_Pcnt,"RefDes","RD_Tag"
"19-REDe","AT-100","0010","001","N”,2,"I","10/10/1999","12/31/
2079","A","B",1,2,"R4-R6",""

Add Component with Unique Reference Designator Text
"Parent","Component","Pt_Use","Seqn","Com_Typ",Quantity,"Qty_Typ","In_Ef
fect","Out_Effect","In_Rev",
"Out_Rev",LT_Offset,Scrap_Pcnt,"Parent_Source","RefDes","RD_Tag"
"19-REDe","AT-100e","0010","001","N",2,"I","10/10/1999","12/31/
2079","A","B",1,2,"1","R1","R1 must be fitted first."
"19-REDe","AT-100e","0010","001","N",2,"I","10/10/1999","12/31/
2079","A","B",1,2,"1","R2","R2 requires R1 placed."
"19-REDe","AT-100e","0010","001","N",2,"I","10/10/1999","12/31/
2079","A","B",1,2,"1","R3","R3 requires R1 and R2 placed."
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Using the Engineering Module
The Engineering Module includes the following applications:

• Product Definition

• Product Release Management

• Workflow Management

Product Definition
Production Definition integrates the item master and bills of material functionality for both 
engineering and production environments. Product Definition includes the following:

• Item Master. Used as the master record that identifies each engineering or production unique 
end-product, assembly, component, material, tool, reference item or resource center used in 
your system. See Item Master for feature information.

• Bills of Material. Used to set up and maintain single level bills of material. See Bill of Material 
for feature information.

• Bills of Material Analysis. Used to review and analyze the single and multi-level bills of 
material.

- See Multi-Level Bill for information on viewing multi-level bills of material.

- See Where Used or Multi-Level Where Used for information on analyzing parents and 
component relationships in bills of material in a “where used” format.

- See Comparison Bill for information on comparing bills of material by effectivity date or 
revision level.

- See Summarized Bill for information on comparing bills of material based on 
summarized data.

- See Comparison of Summarized Bills for information on comparing summarized bills 
of material.

- See Multi-Level Costed Bill for information on simulating bill of material cost roll 
information.

• Product Structure Detail. From the item master and bills of material features, you can add 
and review product structure detail. Product structure detail includes reference designators, 
component detail, lot trace detail, item history and lead time detail. See Product Structure 
Detail for more information.

• Engineering Database Administration. Used to perform engineering system administration 
functions such as setting up user-defined fields and maintaining the supplemental databases. 
See Engineering Database Administration for feature information.

• Engineering Data Import. Used to import engineering item and bills of material data into the 
Engineering database. See Engineering Data Import for feature information.

Item Master
Item Master is used to record each of your company's unique engineering end-product, assembly, 
component, material, tool, reference item or resource center. It is the master record for each of 
your items. Item Master contains information that identifies and describes each item used in your 
engineering and production processes.
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Item Master displays parent and component item information in both a graphical hierarchy and in a 
table (row by column) format. The table format can be customized, for example, to add a second 
row of column headings, add or remove columns or change the column width.

See also Access Methods for more information on accessing this feature.

Bill of Material
Bills of material are constructed one level at a time by entering a parent item and its first-level 
components. As you progress through your product structure entering parent-component 
information, you automatically build the multi-level bill of material for an end-item. While building 
your bill of material, you can view related item detail, such as packaging, planning and stock status 
information.

Bill of Material displays parent and component item information in both a graphical hierarchy and 
in a table (row by column) format. The table format can be customized, for example, to add a 
second row of column headings, add or remove columns or change the column width.

Features available are based on user job functions:

See also Access Methods for more information on accessing this feature.

Multi-Level Bill
Multi-Level Bill is used to view a parent items’ multi-level product structure as of a user-specified 
effectivity date. You can view a flattened bill format by exploding phantom components. Multi-
Level Bill also allows you to view the complete item change history as of a specific revision level or 
effectivity date.

Multi-Level Bill displays component item information in a table (row by column) format based on 
the information entered in the Parent and Component Effectivity Date fields.

The Multi-Level Bill functionality is the same regardless of how it is accessed. See also Access 
Methods for more information on accessing this feature.

Item History
The Item History tab allows you to view an item's inventory history and activity information.

The Item History tab displays beginning, receipt, issue, shipping and adjustment quantities.

Where Used
Where Used is used to list all parent items that directly use a specific component. The list displays 
the single level relationship between a component and all parent items at the next highest level. 
You can also view Item Master detail, such as packaging, planning and stock status information.

Where Used is useful in making mass engineering changes using the Mass Change ability, 
because it shows where a given component is used throughout your company's bills of material.

Access from Features

ENGM Module Set up and maintain the single level bills of material, assign 
reference designators and enter component detail information

MMAM Module View the single level bills of material
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Where Used displays parent and component item information in both a graphical hierarchy and in 
a table (row by column) format. The table format can be customized, for example, to add a second 
row of column headings, add or remove columns or change the column width.

See also Access Methods for more information on accessing this feature.

Multi-Level Where Used
The Multi-Level Where Used is used to list all parent items that directly use a specific component. 
The list displays the single level relationship between a component and all parent items at the next 
highest level. You can also view Item Master detail, such as packaging, planning and stock status 
information. 

Multi-Level Where Used is useful to view end item pegging information, since only the top level, or 
end items, are displayed. Multi-Level Where Used is also useful in making mass engineering 
changes using the Mass Change ability, because it shows where a given component is used 
throughout your company's bills of material.

The Multi-Level Where Used displays parent and component item information in both a graphical 
hierarchy and in a table (row by column) format. The table format can be customized, for example, 
to add a second row of column headings, add or remove columns or change the column width.

See also Access Methods for more information on accessing this feature.

Comparison Bill
Comparison Bill is used to compare bills of material based on parent items or by component 
effectivity date. For example, you can compare Parent 1 to itself, based on different revisions 
(component effectivity dates) or you can compare Parent 1 and Parent 2 from different bills of 
material.

Comparison Bill compares parent, point of use, sequence and component item information in a 
table (row by column) format based on the information entered in the Parent 1, Parent 2 and 
Component Effectivity Dates fields. Use the Hide All Matching Records and Hide All Unmatching 
Records options to easily compare the bills of material information.

The Comparison Bill functionality is the same regardless of how it is accessed. See also Access 
Methods for more information on accessing this feature.

Summarized Bill
Summarized Bill allows you to perform "what if" cost and inventory impact analysis by comparing 
multi-level bills of material where each of the components is listed once with an aggregated 
quantity. Summarized Bill is used to:

• plan for optimal material usage during product phase-out

• assess cost/inventory implications of unplanned impact orders

• generate prioritized material expedite lists

Summarized Bill displays component item information in a table (row by column) format based on 
the information entered in the Parent and Component Effectivity Date fields. 

Features available are based on user job functions:

Access From Features
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When accessed from the MMAM Module, Summarized Bill analysis calculates summarized, 
consumed and required quantity and cost information based on a specified Prod Qty (production 
quantity) value. Information calculated includes:

The Summarized Bill of Material reports available can be sorted in a variety of ways. See 
Generating Reports in the Setting Up the Engineering Module section of the Engineering Analysis 
manual for more information.

See also Access Methods for more information on accessing this feature.

Comparison of Summarized Bills
Comparison of Summarized Bills is used to compare summarized bills in order to identify 
differences between two multi-level bills. Users are able to validate the items and quantities of two 
bills independent of the bill structure. Multi-level bill structures may differ, but the components and 
quantities included may be the same. 

Comparison of Summarized Bills compares parent items in a table (row by column) format based 
on the information entered in the Parent 1, Parent 2 and Component Effectivity Dates fields. 
Comparisons are based on component, quantity type (order or item) and component type. Use the 
Hide All Matching Records and Hide All Unmatching Records options to easily compare the bills of 
material information. 

See also Access Methods for more information on accessing this feature.

Multi-Level Costed Bill
Multi-Level Costed Bill is used to simulate a cost roll for component items based on cost type or 
component effectivity date. Cost rolls can be simulated for either production costs or engineering 
costs for any cost type (0-9, B) that has been defined on the CNFC (Cost Type Setup) screen. A 
simulated cost roll is a snapshot of an item cost for a specific cost type at a specific point in time.

ENGM Module Present a multi-level bill where each of the components is listed once with an 
aggregated quantity. Quantities are aggregated based on make buy (MB), quan-
tity type (QT) and component type (CT).
For example, you may need a purchase requisition for materials still in the engi-
neering phase that means the materials are not in the Fourth Shift inventory. You 
can use the summarized bill of material with aggregated quantities to show your 
material requirements in order to get a purchase requisition.

MMAM Module Present a multi-level bill by specifying a product quantity and an item type to 
consume. Choose to view data from several pre-defined views, such as Summa-
rized Bill by Lead Time or Required Quantity.

Information 
calculated Description

Summarized total quantity/cost needed to produce the Prod Qty specified, taking scrap and 
yield into account.

Consumed quantity/cost taken from Available inventory to fulfill the production of the Prod 
Qty specified

Required quantity/cost, in addition to the consumed amount, needed to fulfill the produc-
tion of the Prod Qty specified
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Multi-Level Costed Bill displays parent and component item cost information in both a graphical 
hierarchy and in a table (row by column) format. The table format can be customized, for example, 
to add a second row of column headings, add or remove columns or change the column width.

See also Access Methods for more information on accessing this feature.

Engineering Database Administration
Engineering Database Administration is used to perform engineering system administration 
functions, such as setting up and defining fields based on user preferences, maintaining the 
supplemental databases associated with the Engineering Module and analyzing the integrity of the 
engineering and Fourth Shift databases.

Engineering Database Administration is divided into sections that include:

See also Access Methods for more information on accessing this feature.

Log file is empty!
An informational message to inform you that the database repair/compact log file does not have 
any processing information. The log file has either recently been deleted or no repair/compacting 
processes have been run yet. Rerun a repair/compact process to regenerate the log file 
information.

Log file has been deleted!
An informational message to inform you that, as requested, the database repair/compact log file 
has been deleted. Rerun the repair/compact process to regenerate the log file information.

Engineering Data Import
Engineering Data Import is used to import data from external sources into the Engineering Module. 
Data, such as engineering items, engineering bills of material, engineering and production 
reference designators and the linkages between engineering and production items can be 
imported into the Engineering database. 

The data from external sources is imported into the Engineering Module using an import file that is 
created by the user. See the Engineering Data Import section for more information on the 
engineering data import file, including the required file format and layouts available when using the 
engineering data import functionality.

Engineering Data Import is divided into sections that include:

Tab Title Description

User Defined Fields Allows you to set up and define fields based on user preferences. Includes a 
header section for defining field values and a table section where fields are dis-
played and can be sorted by field name, caption, data type or whether or not the 
field is required.

Database Mainte-
nance

Allows you to analyze the integrity of the engineering and Fourth Shift data-
bases. A log file (Analyze.LOG) is created during any database maintenance 
process.

Section Description

Import File Allows you to select the file to import.
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See also Access Methods for more information on accessing this feature.

Product Structure Detail
From the item master and bills of material features, you can add and review product structure 
detail. Product structure detail includes engineering component information such as reference 
designators, production component detail, item history, lot trace detail, lead time detail and 
exceptions for bills of materials.

The following tabs are available from the Product Definition screens:

• Engineering. Includes item detail, such as drawing identifiers, cost, price and revision levels 
and the decimal precision associated with the item.

• Production. Includes component detail, references, planning detail, planning fence and stock 
status.

• Item History. Includes an item's inventory history and activity information.

• Lot Trace. Includes an item's lot trace and serialization details.

• Lead Time. Includes cumulative and individual lead times for an item's multi-level product 
structure.

• Exceptions. Notifies you that a reference designator record has become separated from the 
associated parent item.

Engineering
The Engineering tab allows you to enter item detail, such as drawing identifiers, cost, price and 
revision levels associated with the item. You can also enter the DPC (decimal precision) value.

The Engineering tab is divided into sections that include:

Production
The Production tab allows you to enter component detail, references, planning detail, planning 
fence and view stock status.

The Production tab is divided into sections that include:

Import Results Allows you to review the sample data before it is imported and review the results 
of the import.

Tab Title Description

Comp Detail Allows you to enter engineering or production component detail such as in and 
out revision dates. Component specific notes may also be entered. Available 
only from the Engineering Bill of Material or Engineering Where Used features.

Detail Allows you to view engineering item detail, such as engineering drawing identifi-
ers, cost, price and revision levels associated with the item. You can also review 
the DPC (decimal precision) value.

Reference Designator Allows you to enter reference designators and reference designator text for each 
component item on the bill of material. Reference designators can be entered 
individually or in ranges.

Tab Title Description
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Lot Trace
The Lot Trace tab allows you to view an item's lot trace and serialization detail information. 

The Lot Trace tab is divided into sections that include:

Lead Time
The Lead Time tab allows you to view cumulative and individual lead times for an item's multi-level 
product structure in effect as of a user-specified date. You can also simulate lead time changes, 
including changes to the start times as specified by a component's lead time offset. 

The Lead Time tab also allows critical path analysis. You can interactively walk the critical path 
adjusting lead times and lead time offsets while monitoring the impact of simulated changes on the 
cumulative lead time of the parent. 

The Lead Time tab displays parent and component item information in a graphical hierarchy on the 
left side and the related lead time information in a Gantt chart on the right side.

The Lead Time tab is only available from the Multi-Level Bill of Material and its functionality is the 
same regardless of how it is accessed. See also Access Methods for more information on 
accessing this feature.

The Gantt Chart has several display features:

• Daily time increments are displayed by the horizontal axis. Chart scaling is displayed along the 
top of the chart.

Comp Detail Allows you to enter engineering or production component detail such as in and 
out revision dates. Component specific notes may also be entered. Available 
only from the Production Bill of Material or Production Where Used features.

References Allows you to view classification information, such as item class codes and fam-
ily grouping, to further define the item. All entries are optional and should be 
used if your company requires a detailed record for the item

Packaging Allows you to view specific shipping and packaging information, such as ship-
ping weight or package type, to further define the item. All entries are optional 
and should be used if your company requires a detailed record for the item.

Planning Detail Allows you to view planning information, such as preferred location and lead 
time. Used as key references by the system to make planning calculations.

Planning Fence Allows you to view planning information, such as forecast codes and lot size 
quantities. Used as key references by the system to make planning calculations.

Stock Status Allows you to view an item's current inventory status. Provides information on 
the quantity for each inventory classification (on hand, in-inspection, shipping, 
on-hold and internal and external WIP) and inventory value based upon ITMC 
Cost Type 0.

Tab Title Description

Detail Allows you to view an item's lot trace and serialization detail information. Pro-
vides information such as policies, calendar days and text messages.

Lot / SN Allows you to view an item's lot trace and serialization number detail. Provides 
information such as lot and serial mask, default and last number used.
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• Each component is displayed by one line:

• The starting point of a line, represented by the right vertical line, indicates when the 
component is needed. This date is based on lead times of higher-level items to determine 
when a component's parent item should be started.

• The critical path of components to manufacture the parent item is displayed with red lines by 
default. When more than one critical path exists, only the last one (nearest the bottom of the 
Gantt chart) is displayed in red. Critical paths are marked with an asterisk (*) in the graphical 
hierarchy.

• The normal, highlighted and critical path line colors can be customized by selecting Options 
from the View menu.

• The cumulative lead time for the parent item, based on the critical path of components, is 
displayed in the Cum LT field.

Exceptions
The Exceptions tab notifies you that a reference designator record in the engineering database 
has become separated, or "orphaned" from the associated parent item in the bill of material in the 
manufacturing database.

The Exceptions tab displays the "orphaned" reference designator records and is active only when 
reference designator exceptions exist. The Exceptions tab is only available from the Bill of 
Material.

Product Release Management
Product Release Management allows administrators to set up conditions and define the rules that 
are considered when an item is being released to the next phase, such as from engineering to pre-
production or from pre-production to production. To aid the product release manager, sample rule 
definitions are included which can be customized for your specific release requirements.

• Set Up Rule Definitions. Setting up rule definitions involves setting up selection and edit 
conditions and assigning the conditions to rules. See Product Release Rule Definitions for 
feature information.

• Release Items. Once conditions and rules have been defined, the rule definitions are used as 
criteria for releasing items between the three specified release levels.

Example
• Make Items Only. You can create a rule that will check only the make items. The rule 

selection criteria would look similar to “MB is equal to M”. When an item is being released from 
one phase to the next, only items that meet the selection criteria (MB = M) will be considered.

• Inspection Based on Cost. You can create a rule that all items over a specified cost must be 
inspected. The rule selection criteria would look similar to “Cost >> $250” and “Inspection 

Line Type Description

Solid single buy item

Solid double make item with a normal component type (CT = N)

Dashed double a make item with a phantom component type (CT = P)

Line length Component's lead time
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Instructions is not blank or null”. When an item that costs more than $250 is selected for 
promotion, it will only be promoted if the item has been inspected.

Product Release Rule Definitions
Product Release Rule Definitions is used by product release managers to set up the conditions 
and define the rules that are considered when an item is being released to the next release phase.

• Set Up Conditions. Users set up selection and edit condition criteria which is used to 
evaluate the item prior to release. 

• Define Rules. Users create rules and then assign conditions to the rules based upon your 
company’s specifications. Two sets of rules are defined for releasing items: rules to release 
from Phase 1 to Phase 2 and rules to release from Phase 2 to Phase 3. Rule severity, 
warning, or failure must be assigned to each rule.

Product Release Rule Definitions is divided into sections that include:

See also Access Methods for more information on accessing this feature.

Workflow Management
Workflow Management provides the ability to set up and manage a workflow process based on the 
way your business operates. To aid the workflow administrator, document and routing templates 
are included which can be used as a starting point and then customized with your specific 
requirements.

• Setting Up a Workflow. Setting up a workflow process includes defining users, groups, 
activities and routing templates. See Routing Template Administration for feature information.

• Managing a Workflow. Managing a workflow process includes starting a process, tracking 
the status and analyzing the disposition results. See Process Status and Disposition for 
feature information.

Example
For example, you may want to set up a process for recording impact analysis of safety changes 
made within your company. Approvals from the managers of the Operations Management and 
Development Services departments could be required for the safety change to be approved. This 
process would look similar to the following:

Tab Title Description

Selection/Edit Condi-
tions
(left side)

Used to set up and define the selection and edit condition criteria which is used 
to evaluate the item prior to release.

Rules
(right side)

Used to create rules and then assign selection and edit conditions. Also used to 
determine the rule severity (warning or failure).
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Routing Template Administration
Routing Template Administration is used by workflow administrators to define and set up the areas 
of a workflow process. The workflow areas that must be defined include users, groups, activities 
and routing templates. A workflow process can be any procedure used within your company that 
involves several levels of steps or instructions.

Routing Template Administration is divided into sections that include:

See also Access Methods for more information on accessing this feature.

Process Status and Disposition
Process Status and Disposition is used by workflow administrators or individual users to manage a 
workflow process. Workflow administrators can access all processes, but individual users can 
access only the processes that are assigned to the individual's user identifier. Managing a process 
includes the following:

• Select Routing. Select a routing template as the base of your process.

• Customize. Customize the process with your company’s requirements, such as adding 
groups or documents.

Tab Title Description

Groups Users. Used to create users who are involved in the workflow process.
Groups. Used to create groups or project responsibilities that are involved in the 
workflow process. Users are assigned to groups which represent how your com-
pany operates. Groups are notified in parallel within an activity, which means 
that once an activity has started, all groups within that activity are notified at the 
same time.

Activities Used to define the set of activities required to complete the workflow process. 
Activity definitions are then used to communicate information among members 
of the groups. Activities are performed serially within a process, which means 
that one activity must be completed before the next activity can start.

Routing Templates Used to define the routing sequence for each activity. Because activities are per-
formed serially within a process, it is important to define the sequence of when 
you want the activities to be performed.

Routing: Safety Change

Activity: Record Impact Analysis

Group:
Operations Management

Users:
Managers

Group:
Development Services

Users:
Managers

Dispositions: approve or reject the safety change
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• Route. Route to the appropriate reviewers via electronic mail to notify them that a process has 
been started.

• Review Dispositions. Review the dispositions, either approve or reject, which are entered by 
all users in the groups that are assigned to the process. Users can change their disposition 
as long as it is not the final disposition in an activity. Reviewing dispositions allows 
you to monitor the progress of each process and allows you to see if a process is being held 
up by a certain activity or group.

• Restart. A process can be restarted if the workflow administrator does not accept the final 
process disposition. The process is restarted by changing the process status from “completed” 
back to “in process.”

Process Status and Disposition is divided into sections that include:

See also Access Methods for more information on accessing this feature.

Section Description

Process
(left side)

Used to maintain workflow processes. Administrators can review the entire list of 
processes. Users can only review processes assigned to them.

Disposition
(right side)

Used to maintain dispositions on a process which has been routed to you. Dispo-
sition actions can include adding comments, and then either an approval or a 
rejection.
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ECRD – Process Status and Disposition
Process Status and Disposition is used by workflow administrators or individual users to manage a 
workflow process. Workflow administrators can access all processes, but individual users can access only 
the processes that are assigned to the individual's user identifier. Managing a process includes the 
following:

• Select Routing. Select a routing template as the base of your process.

• Customize. Customize the process with your company’s requirements, such as adding 
groups or documents.

• Route. Route to the appropriate reviewers via electronic mail to notify them that a process has 
been started.

• Review Dispositions. Review the dispositions, either approve or reject, which are entered by 
all users in the groups that are assigned to the process. Users can change their disposition as 
long as it is not the final disposition in an activity. Reviewing dispositions allows you to monitor 
the progress of each process and allows you to see if a process is being held up by a certain 
activity or group.

• Restart. A process can be restarted if the workflow administrator does not accept the final 
process disposition. The process is restarted by changing the process status from “completed” 
back to “in process.”

Process Status and Disposition is divided into sections which include:

Fields
Activity Status

Activity Status indicates the activity's current position on the process disposition. Activity 
Status options include:

Not Started.  Disposition process has not yet begun for the activity.
In Process.  Disposition process has begun for the activity.
Approved.  All groups associated with the activity have approved the process.
Rejected.  At least one group associated with the activity has rejected the process.

Where Used: Process Status and Disposition

Activity Title
Activity Title is the title, or short description, of the activity which is pre-defined by the 
workflow management administrator during the workflow setup process. The Activity Title is 

Section Description

Process
(left side)

Used to maintain workflow processes. Administrators can review the entire list of 
processes. Users can only review processes assigned to them.

Disposition
(right side)

Used to maintain dispositions on a process which has been routed to you. Dispo-
sition actions can include adding comments, and then either an approval or a 
rejection.
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displayed throughout the application to identify the activity associated with the group and 
Process Number . Entry is any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition; Routing Template Administration

Additional Notes
Additional Notes is an explanation of, or any additional information pertaining to, the process 
disposition. Additional Notes can only be added during the process disposition process. 
Additional Notes are stored as historical entries in the Disposition Notes field for the 
specific process for which they were entered. Entry is any alphanumeric combination of up to 
10,000 characters.

Where Used: Process Status and Disposition

Allow Days
Allowed Days to Disposition specifies the number of days given to the disposition process, 
either to approve or reject, for a specified process. Allowed Days is based on calendar days 
and is determined by the workflow management administrator during the activity setup 
process.

Where Used: Process Status and Disposition; Routing Template Administration

Comments
Comments includes additional general information pertaining to the process. Comments can 
entered any time during the routing of the process. Entry is any alphanumeric combination of 
up to 10,000 characters.

Where Used: Process Status and Disposition

Date
Date and Time is the day, month and year by which system transactions are identified. Often 
displayed after the date is the time, in hours, minutes and seconds, that the transaction took 
place.

Where Used: Process Status and Disposition

Date Completed
Date Completed is the day, month and year that the routing activity is approved for a specific 
process. The Date Completed is when all users within all groups within a specific activity 
have approved the process. Often displayed after the date is the time, in hours, minutes and 
seconds, that the activity was completed.
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Where Used: Process Status and Disposition

Date Completed Range
Date Completed Range is the beginning and ending of a date range which identifies when 
the routing activity was completed for a specific process. Date Completed Range is used as 
selection criteria when defining views for reviewing processes.

Where Used: Process Status and Disposition

Date Started
Date Started is the day, month and year that the routing activity started for a specific process. 
Often displayed after the date is the time, in hours, minutes and seconds, that the activity 
started.

Where Used: Process Status and Disposition

Date Started Range
Date Started Range is the beginning and ending of a date range which identifies when the 
routing activity started for a specific engineering process. Date Started Range is used as 
selection criteria when defining views for reviewing processes.

Where Used: Process Status and Disposition

Description
Routing Template Description is the description of the routing template that is pre-defined 
by the workflow management administrator during the workflow setup process. Entry is any 
alphanumeric combination of up to 10,000 characters.

Where Used: Process Status and Disposition

Directory
Directory identifies the system-generated directory location where any documents, or 
attachments, are stored for a specific process. The directory location is created as a sub-
directory off the Mfgsys\Engm\Ecr_Docs directory. Directories are created and named 
sequentially, starting with a number sequence predefined by the workflow management 
administrator during the workflow setup process.

Where Used: Process Status and Disposition; Routing Template Administration

Disposition
Disposition is the action you wish to take for a specific process after reviewing the process 
routing package. Disposition options include:
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Approve. You approve the process, which is then routed to the next group or 
activity for review and disposition.
Reject. You do not approve the process. 
In Process. The workflow management administrator determines that an approved 
or rejected process must be sent back into the disposition process.

Where Used: Process Status and Disposition

Disposition Notes
Disposition Notes is a historical summary of any disposition comments or additional notes 
that were entered for the specific process. Disposition Notes can also include automatically 
generated messages based on process disposition activity, such as process status changes.

Where Used: Process Status and Disposition

Document Description
Document Description is the user-defined description of the document, or attachment, which 
is included in the routing package for the related process. Entry is any alphanumeric 
combination of up to 10,000 characters.

Where Used: Process Status and Disposition; Routing Template Administration

Document Title
Document Title is the user-defined title, or short description, of the document, or attachment, 
which is included in the routing package for the related process. The Document Title is 
displayed throughout the application to identify the document related to the process. Entry is 
any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition; Routing Template Administration

File Name
Attachment File Name identifies the source directory path and file name of the document, or 
attachment, which is included in the routing package for the related process. 

Where Used: Process Status and Disposition; Routing Template Administration

Group Status
Group Status indicates the group's current position on the process disposition. Group Status 
options include:

Not Started.  Disposition process has not yet begun for the activity.
In Process.  Disposition process has begun for the activity.
Approved.  All users associated with the group have approved the process.
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Rejected.  At least one user associated with the group has rejected the process.

Where Used: Process Status and Disposition

Group Title
Group Title is the title, or short description, of the group that is pre-defined by the workflow 
management administrator during the workflow setup process. The Group Title is displayed 
throughout the application to identify the group associated with the User Name and Process 
Number. Entry is any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition; Routing Template Administration

Initiated By
Initiated By is the identification of the individual who created the process. 

Where Used: Process Status and Disposition

Process Initiated By
Process Initiated By is the identification of the individual who started the process.

Where Used: Process Status and Disposition

Process Number
Process Number is the unique identifier for a workflow process. The Process Number 
consists of an optional prefix identifier and a system-generated number. The prefix identifier 
and starting number are pre-defined by the workflow management administrator during the 
workflow setup process. The Process Number cannot be changed once the process has 
been entered into the system.

Where Used: Process Status and Disposition

Process Title
Process Title is the title, or short description, of the process that is pre-defined by the 
workflow management administrator during the workflow setup process. The Process Title is 
displayed throughout the application to identify the process represented by the Process 
Number. Entry is any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition
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Routing Template
Routing Template identifies the type of routing selected for the related process. Routing 
Templates are pre-defined by the workflow management administrator during the workflow 
setup process. A routing template must be assigned for each process created. 

Where Used: Process Status and Disposition; Routing Template Administration

Status
Workflow Process Status indicates the current position of the process. Options include:

Composition.  The process has been created and the process number has been 
assigned. The process has not been routed. 
In Process.  The process is currently being routed to the appropriate reviewers for 
analysis and disposition.
Complete.  Analysis on the process is complete and all dispositions, either 
approved or rejected, for the process have been entered. 

Where Used: Process Status and Disposition

Target Completion
Target Completion Date identifies the system-generated date when all dispositions should 
be completed. The Target Completion Date is calculated using Date Started + Allowed 
Days to Disposition. The Target Completion Date field highlights if the current system date 
is later than the target completion data specified.

Where Used: Process Status and Disposition

User Name
User Name identifies the individual associated with the User Id. User Name is the 
combination of the First Name and Last Name identified for the user. 

Where Used: Process Status and Disposition

User Status
User Status indicates the user's current position on the process disposition. User Status 
options include:

Not Started.  Disposition process has not yet begun for the activity.
In Process.  Disposition process has begun for the activity.
Approved.  User has approved the process.
Rejected.  User has not approved the process.

Where Used: Process Status and Disposition
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View
View is the user-defined name which is associated with the view filtering properties specified 
by the user. Entry is any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition
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WKFL – Routing Template Administration
Routing Template Administration is used by workflow administrators to define and set up the areas of a 
workflow process. The workflow areas that must be defined include users, groups, activities and routing 
templates. A workflow process can be any procedure used within your company that involves several 
levels of steps or instructions.

Routing Template Administration is divided into sections that include:

Fields
Activities

Activities is an alphabetical list of the activities that are available to be assigned to processes 
by the workflow management administrator during the workflow setup process. Activity 
hierarchy can be expanded to view the groups and users assigned to each activity. Each 
activity is defined by activity title. Optionally, each activity can be defined by activity 
description, electronic mail default message and the number of days allowed for the 
disposition of the activity.

Where Used: Routing Template Administration

Activity Description
Activity Description is the description of the activity which is pre-defined by the workflow 
management administrator. Entry is any alphanumeric combination of up to 10,000 
characters.

Where Used: Routing Template Administration

Activity title
Activity Title is the title, or short description, of the activity which is pre-defined by the 
workflow management administrator during the workflow setup process. The Activity Title is 

Tab Title Description

Groups Users. Used to create users who are involved in the workflow process.
Groups. Used to create groups or project responsibilities that are involved in the 
workflow process. Users are assigned to groups which represent how your com-
pany operates. Groups are notified in parallel within an activity, which means that 
once an activity has started, all groups within that activity are notified at the same 
time.

Activities Used to define the set of activities required to complete the workflow process. 
Activity definitions are then used to communicate information among members of 
the groups. Activities are performed serially within a process, which means that 
one activity must be completed before the next activity can start.

Routing Templates Used to define the routing sequence for each activity. Since activities are per-
formed serially within a process, it is important to define the sequence of when 
you want the activities to be performed.
Engineering 71



Fourth Shift Release 8.00 WKFL – Routing Template Administration
displayed throughout the application to identify the activity associated with the group and 
Process Number . Entry is any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition; Routing Template Administration

Allowed Days
Allowed Days to Disposition specifies the number of days given to the disposition process, 
either to approve or reject, for a specified process. Allowed Days is based on calendar days 
and is determined by the workflow management administrator during the activity setup 
process.

Where Used: Process Status and Disposition; Routing Template Administration

Directory
Directory identifies the system-generated directory location where any documents, or 
attachments, are stored for a specific process. The directory location is created as a sub-
directory off the Mfgsys\Engm\Ecr_Docs directory. Directories are created and named 
sequentially, starting with a number sequence predefined by the workflow management 
administrator during the workflow setup process.

Where Used: Process Status and Disposition; Routing Template Administration

Document Description
Document Description is the user-defined description of the document, or attachment, which 
is included in the routing package for the related process. Entry is any alphanumeric 
combination of up to 10,000 characters.

Where Used: Process Status and Disposition; Routing Template Administration

Document Title
Document Title is the user-defined title, or short description, of the document, or attachment, 
which is included in the routing package for the related process. The Document Title is 
displayed throughout the application to identify the document related to the process. Entry is 
any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition; Routing Template Administration

Documents
Documents is an alphabetical list of the documents that are available to be assigned to 
processes by the workflow management administrator during the workflow setup process. 
Each document is defined by document title, document description and file name. A directory 
for the document is assigned when the document is assigned to a process.
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Where Used: Routing Template Administration

File Name
Attachment File Name identifies the source directory path and file name of the document, or 
attachment, which is included in the routing package for the related process. 

Where Used: Process Status and Disposition; Routing Template Administration

First Name
First Name identifies the first name, or given name, of the user. Entry is up to 25 
alphanumeric characters.

Where Used: Routing Template Administration

Group Description
Group Description is the description of the group that is pre-defined by the workflow 
management administrator during the workflow setup process. Entry is any alphanumeric 
combination of up to 10,000 characters.

Where Used: Routing Template Administration

Group Title
Group Title is the title, or short description, of the group that is pre-defined by the workflow 
management administrator during the workflow setup process. The Group Title is displayed 
throughout the application to identify the group associated with the User Name and Process 
Number. Entry is any alphanumeric combination of up to 50 characters.

Where Used: Process Status and Disposition; Routing Template Administration

Groups
Groups is an alphabetical list of the groups that are available to be assigned to activities by 
the workflow management administrator during the workflow setup process. Group hierarchy 
can be expanded to view the users assigned to each group. Each group is defined by group 
title. Optionally, a group can also be defined by group description. 

Where Used: Routing Template Administration

Last Name
Last Name identifies the last name, or surname, of the user. Entry is up to 25 alphanumeric 
characters.
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Where Used: Routing Template Administration

Login Id
User Identification is your identification as entered to sign onto the system. Entry is any 
alphanumeric combination of up to 4 characters.

Where Used: BEXE; Fourth Shift Sign-On; G/L Batch Detail; G/L Recurring/Template Trans 
Detail; G/L Transaction Detail; GLAU; GLJL; GLPC; PASS; Routing Template Administration; 
TRUD

Mail Id
Mail Id is user’s display name that is displayed in the mail “To”. If a Mail Id is not specified, 
Mail Address will be used as display name. The Mail server will (if possible) resolve the mail 
address and use the internal user name as the display name in the mail even if the Mail Id is 
specified. 

Where Used: Routing Template Administration

Note: See Setting Up Mail Identifiers in the Workflow Using Electronic Mail section for more 
information.

Mail Address
Mail Address is your address identification as defined in your electronic mail system. A Mail 
Address allows you to enter additional electronic mail information for each mail recipient. For 
example, you can specify an electronic mail post office address or an Internet address of a 
mail recipient outside of your company's mail system. A Mail Address should be specified for 
all users who are involved in the routing process, including those who review and give 
dispositions and those who are notified of pending changes. 

Where Used: Routing Template Administration

Note: See Setting Up Mail Identifiers in the Workflow Using Electronic Mail section for more 
information.

Routing Templates
Routing Template identifies the type of routing selected for the related process. Routing 
Templates are pre-defined by the workflow management administrator during the workflow 
setup process. A routing template must be assigned for each process created. 

Where Used: Process Status and Disposition; Routing Template Administration

Starting Number
Starting Number identifies the initial sequential number to use with the Template Prefix 
when the system generates the number. A starting process number can be optionally 
determined for each template prefix defined. Entry for the initial sequential number is up to 6 
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numeric characters. If a Starting Number is not defined, the initial sequential number is 
000001.

Where Used: Routing Template Administration

Startup Message
Startup Message identifies the user-defined message that is displayed in the electronic mail 
message which is sent to the users when the activity is started. Entry is any alphanumeric 
combination of up to 50 characters.

Where Used: Routing Template Administration

Template Description
Template Description is the description of the routing template that is pre-defined by the 
workflow management administrator during the workflow setup process. Entry is any 
alphanumeric combination of up to 10,000 characters.

Where Used: Routing Template Administration

Template Name
Routing Template identifies the type of routing selected for the related process. Routing 
Templates are pre-defined by the workflow management administrator during the workflow 
setup process. A routing template must be assigned for each process created. 

Where Used: Process Status and Disposition; Routing Template Administration

Template Prefix
Template Prefix identifies a pattern to use as a prefix when generating a template routing. 
Template Prefix is optionally pre-defined by the workflow management administrator during 
the workflow setup process. Entry for the prefix is any alphanumeric combination up to 20 
characters.

Where Used: Routing Template Administration

Users
Users is an alphabetical list of the individuals who are available to be assigned to groups by 
the workflow management administrator during the workflow setup process. Each user is 
defined by user id and last name. Optionally, each user can be defined by first name, 
electronic mail identifier and electronic mail address. Users can be assigned to more than one 
group.

Where Used: Routing Template Administration
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EBLL – Bill of Material
Bills of material are constructed one level at a time by entering a parent item and its first-level components. 
As you progress through your product structure entering parent-component information, you automatically 
build the multi-level bill of material for an end-item. While building your bill of material, you can view related 
item detail, such as packaging, planning and stock status information.

Bill of Material displays parent and component item information in both a graphical hierarchy and in a table 
(row by column) format. The table format can be customized, for example, to add a second row of column 
headings, add or remove columns or change the column width.

Features available are based on user job functions:

Reports

Bill of Material Reports
To generate the report, choose Print Preview from the File menu.

Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 

Access from Features

ENGM Module Set up and maintain the single level bills of material, assign reference 
designators and enter component detail information

MMAM Module View the single level bills of material

Report Title

Engineering Single Level Bill with Reference Designator Text
Lists components and reference designator text for an engineering bill.

Engineering Single Level Bill with Reference Designators
Lists components and reference designators for an engineering bill.

Production Single Level Bill with Reference Designator Text
Lists components and reference designator text for a production bill.

Production Single Level Bill with Reference Designators
Lists components and reference designators for a production bill.
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Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE
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CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.
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An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.
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Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Fixed LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

In Effectivity
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
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Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Out Effectivity
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE
Engineering 81



Fourth Shift Release 8.00 EBLL – Bill of Material
Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master
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Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Pt Use Defines Embedded Revision
Pt Use Defines Embedded Revision specifies the three key characters in the Pt Use field 
that uniquely identify revision history components in a bill of material. The recommended value 
is REV. If REV has previously been used to define a workcenter, another identification prefix 
must be used.

Where Used: Bill of Material; Summarized Bill

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE
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Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Ref Des Count
Reference Designator Count is the total number of unique reference designator identifiers 
entered as Reference Designators associated with a component. For example, the 
Reference Designator Count = 3 for reference designators entered as a range of D1-D3 for a 
specified component.

Where Used: Bill of Material; Comparison Bill; Multi-Level Bill; Where Used

Reference Designators
Reference Designators are unique identifiers which allow engineers to assign control 
information such as device callouts to a component within a Bill of Material. Ranges can be 
used to organize multiple sequential reference designator identifiers. Entry is up to 10 
characters.

Where Used: Bill of Material; Comparison Bill; Engineering; Exceptions; Multi-Level Bill; 
Where Used

Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master
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Rv
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
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Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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ECMP – Comparison Bill
Comparison Bill is used to compare bills of material based on parent items or by component effectivity 
date. For example, you can compare Parent 1 to itself, based on different revisions (component effectivity 
dates) or you can compare Parent 1 and Parent 2 from different bills of material.

Comparison Bill compares parent, point of use, sequence and component item information in a table (row 
by column) format based on the information entered in the Parent 1, Parent 2 and Component Effectivity 
Dates fields. Use the Hide All Matching Records and Hide All Unmatching Records options to easily 
compare the bills of material information.

The Comparison Bill functionality is the same regardless of how it is accessed.

Reports

Comparison Bill Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists comparisons of engineering parent items.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Comparison Bill

Fields
Component

Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 

Report Title

Engineering Comparison Bill of Material
Lists comparisons of engineering parent items.

Production Comparison Bill of Material
Lists comparisons of production parent items.
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Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used
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Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
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Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Engineering 90



Fourth Shift Release 8.00 ECMP – Comparison Bill
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

In Effect
In Effectivity is the first In Effectivity date, which should be considered valid to display for this 
bill of material. Entry is 6 numbers in the system date format. Default is 010180.

Where Used: BILI; BILL; Comparison Bill

In Effectivity
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

In Rev
In Revision Level indicates the level of documentation for which the parent-component 
relationship becomes effective. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Out Effect
Out Effectivity is the last Out Effectivity date which should be considered valid to display for 
this bill of material. Entry is 6 numbers in the system date format. Default is 123179 when U.S. 
date format is used.

Where Used: BILI; BILL; Comparison Bill
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Out Effectivity
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Out Rev
Out Revision Level indicates the level of documentation for which the parent-component 
relationship is no longer in effect. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Parent Item
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Production Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
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structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE
Engineering 93



Fourth Shift Release 8.00 ECMP – Comparison Bill
QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Ref Des Count
Reference Designator Count is the total number of unique reference designator identifiers 
entered as Reference Designators associated with a component. For example, the 
Reference Designator Count = 3 for reference designators entered as a range of D1-D3 for a 
specified component.

Where Used: Engineering; Exceptions

Reference Designators
Reference Designators are unique identifiers which allow engineers to assign control 
information such as device callouts to a component within a Bill of Material. Ranges can be 
used to organize multiple sequential reference designator identifiers. Entry is up to 10 
characters.
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Where Used: Bill of Material; Comparison Bill; Engineering; Exceptions; Multi-Level Bill; 
Where Used

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE
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ECMS – Comparison of Summarized Bills
Comparison of Summarized Bills is used to compare summarized bills in order to identify differences 
between two multi-level bills. Users are able to validate the items and quantities of two bills independent of 
the bill structure. Multi-level bill structures may differ, but the components and quantities included may be 
the same. 

Comparison of Summarized Bills compares parent items in a table (row by column) format based on the 
information entered in the Parent 1, Parent 2 and Component Effectivity Dates fields. Comparisons are 
based on component, quantity type (order or item) and component type. Use the Hide All Matching 
Records and Hide All Unmatching Records options to easily compare the bills of material information.

Reports

Comparison of Summarized Bills Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists comparisons of summarized engineering parent items.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Comparison of Summarized Bills

Fields
Component

Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 

Report Title

Engineering Comparison of Summarized Bills
Lists comparisons of summarized engineering parent items.

Production Comparison of Summarized Bills
Lists comparisons of summarized production parent items.
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Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used
Engineering 97



Fourth Shift Release 8.00 ECMS – Comparison of Summarized Bills
Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.
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Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Item
Item is the unique identifier for a part used in the Engineering module, whether it be a piece 
part, tool, raw material, an assembly, or finished product. Within a product structure, an item 
can be a component as well as a parent. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: EITB; ECMS; ECRL; EMLB; EMWU; ESMB

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Parent Item
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Production Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
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Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE
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ECRL – Multi-Level Costed Bill
Multi-Level Costed Bill is used to simulate a cost roll for component items based on cost type or 
component effectivity date. Cost rolls can be simulated for either production costs or engineering costs for 
any cost type (0-9, B) that has been defined on the CNFC (Cost Type Setup) screen. A simulated cost roll 
is a snapshot of an item cost for a specific cost type at a specific point in time.

Multi-Level Costed Bill displays parent and component item cost information in both a graphical hierarchy 
and in a table (row by column) format. The table format can be customized, for example, to add a second 
row of column headings, add or remove columns or change the column width.

Reports

Multi-Level Costed Bill Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists costing information for a multi-level engineering bill.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Multi-Level Costed Bill

Fields
Added at This Level

Added at This Level is the value-added cost to manufacture the item in terms of material, 
labor, fixed overhead and variable overhead costs. Added at This Level costs and rolled 
costs of the item's components are used to calculate the item's Total Rolled Cost. Entry is 
any alphanumeric combination of up to 15 characters.

Where Used: CMLB; Costed Bill Detail; CSLB; Multi-Level Costed Bill

Report Title

Engineering Multi-Level Costed Bill
Lists costing information for a multi-level engineering bill.

Production Multi-Level Costed Bill
Lists costing information for a multi-level production bill.
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Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

Cost Code
Cost Code specifies the approach for calculating the rolled cost for an item. Item costs are 
calculated manually or automatically by totaling the component costs and may include scrap 
and/or yield. Entry options include:

0 = Manual
1 = Automatic (scrap and yield)
2 = Automatic (scrap)
3 = Automatic (yield)
4 = Automatic (not scrap or yield)
5 = Automatic (not in parent rolled cost)
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6 = Manual (not in parent rolled cost)

Where Used: CMLB; Cost Selection; Cost Update Selection (from MCST); Cost Update 
Selection (from PCST); Costed Bill Detail; CSLB; ITCI; ITHC; ITMC; Multi-Level Costed Bill

Cost Type
Cost Type specifies the basis for item cost. You can define up to 11 Cost Types using the 
CNFC screen. Cost Type 0 is always used for inventory valuation. Entry options include:

0 = Cost Type 0
1 = Cost Type 1
2 = Cost Type 2
3 = Cost Type 3
4 = Cost Type 4
5 = Cost Type 5
6 = Cost Type 6
7 = Cost Type 7
8 = Cost Type 8
9 = Cost Type 9
B = Cost Type B (budget)

Where Used: CMLB; CNFC; COMP; Cost Estimate by Lot Size; Cost Selection; Costed Bill 
Detail; CSLB; ITBI; ITCB; ITCI; ITHC; ITMC; Multi-Level Costed Bill; QUOI; QUOT

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
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Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Fixed OH
Fixed Overhead Cost is the amount of allocated fixed cost to build an item with the item's 
first-level components. It normally includes costs such as occupancy and equipment which do 
not change as the production level goes up or down. Fixed Overhead Cost can be specified 
for each Cost Type established for an item. Entry is up to 16 numbers.

Where Used: ITCI; ITHC; ITMC; Multi-Level Costed Bill; QUOI; QUOT

Item
Item is the unique identifier for a part used in the Engineering module, whether it be a piece 
part, tool, raw material, an assembly, or finished product. Within a product structure, an item 
can be a component as well as a parent. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Engineering; EITB; ECMS; ECRL; EMLB; EMWU; ESMB

Labor
Labor Cost is the amount of labor needed to build an item with the item's first-level 
components. Labor Cost can be specified for each Cost Type established for an item. Entry is 
up to 16 numbers.

Where Used: ITCI; ITHC; ITMC; Multi-Level Costed Bill; QUOI; QUOT
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Level
Item Level indicates the position of an item within a product structure. Level is used to show 
the relative position of an item in relationship to its higher-level parent or lower-level 
components. Entry is any alphanumeric combination.

Where Used: CMLB; Location Index; LOTR; MBIL; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE

Matl
Material Cost is the cost for the engineering item entered when that item is defined. It is not a 
calculated field.

Where Used: EITB; ECRL; ESMB; Engineering

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Rolled Fixed OH
Rolled Fixed Overhead Cost is the total fixed overhead cost to manufacture an item. It is the 
sum of the fixed overhead costs of the item's components and the Fixed Overhead Cost of 
the item itself. Displays are based on the specified Cost Type. Entry is up to 16 numbers. 
Decimal places are allowed.
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Where Used: Cost Update Selection (from MCST); Cost Update Selection (from PCST); 
ITCI; ITMC; Multi-Level Costed Bill

Rolled Labor
Rolled Labor Cost represents the total labor cost to manufacture an item. It is the sum of the 
labor costs of the item's components and the Labor Cost of the item itself. Displays are based 
on the specified Cost Type. Entry is up to 16 numbers. Decimal places are allowed.

Where Used: Cost Update Selection (from MCST); Cost Update Selection (from PCST); 
ITCI; ITMC; Multi-Level Costed Bill

Rolled Matl
Rolled Material Cost represents the total material cost to manufacture an item and is the sum 
of the material costs of the item's components. Displays are based on the specified Cost Type. 
Entry is up to 16 numbers. Decimal places are allowed.

Where Used: Cost Update Selection (from MCST); Cost Update Selection (from PCST); 
ITCI; ITMC; Multi-Level Costed Bill

Rolled Variable OH
Rolled Variable Overhead Cost represents the total variable overhead cost to manufacture 
an item. It is the sum of the variable overhead costs of the item's components and the 
Variable Overhead Cost of the item itself. Displays are based on the specified Cost Type. 
Entry is up to 16 numbers. Decimal places are allowed.

Where Used: Cost Update Selection (from MCST); Cost Update Selection (from PCST); 
ITCI; ITMC; Multi-Level Costed Bill

Variable OH
Variable Overhead Cost is the amount of allocated variable cost to build an item with the 
item's first-level components. It normally includes costs such as employee benefits and 
machine power, which change as the production level goes up or down. Variable Overhead 
Cost can be specified for each Cost Type established for an item. Entry is up to 16 numbers. 
Decimal places are allowed.

Where Used: ITCI; ITHC; ITMC; Multi-Level Costed Bill; QUOI; QUOT
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EDBA – Engineering Database Administration
Engineering Database Administration is used to perform engineering system administration functions, 
such as setting up and defining fields based on user preferences, maintaining the supplemental databases 
associated with the Engineering Module and analyzing the integrity of the engineering and Fourth Shift 
databases.

Engineering Database Administration is divided into sections that include:

Fields
Caption Lines 1-2

Caption Lines 1-2 identifies the label for the user defined field when used in a table column 
heading, such as in the Item Master or Bill of Material. Caption Lines 1-2 also define how the 
field label is separated if more than one line is available when displayed. The field label 
entered for Line 1 displays in the top line of the column heading. The field label entered for 
Line 2 displays below the bottom line of the column heading. The width of the column heading 
for user-defined fields is based on the caption lines entered. 

Where Used: Engineering Database Admin

Data Type
Data Type identifies the format of the data that is stored in the user-defined field. Data types 
include the following:

- Text

- Memo

- Date / Time

- Currency

- Yes / No

- OLE Object

- Number - Integer

Tab Title Description

User Defined Fields Allows you to set up and define fields based on user preferences. Includes a 
header section for defining field values and a table section where fields are dis-
played and can be sorted by field name, caption, data type or whether or not the 
field is required.

To create a user-defined field, right-click on New or go to File > New. Then go to 
Expression Builder to enter the new user-defined fields.

See User-Defined Fields: Format Property (Access only) in the Setting Up 
the Engineering Module section for more information.

Database Mainte-
nance

Allows you to analyze the integrity of the engineering and Fourth Shift databases. 
A log file (Analyze.LOG) is created during any database maintenance process.
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- Number - Long Integer

- Number - Single Precision

- Number - Double Precision

- Byte (8-bit)

A data type must be defined for each user-defined field.

Where Used: Engineering Database Admin

Decimals
Decimals identifies the number of digits to the right of the separator. Decimal precision 
options include 1-15 and automatic. A decimal precision option must be specified for each 
user-defined field if the field has a Data Type = any type of number. 

Where Used: Engineering Database Admin - (Access only)

Default Value
Default Value identifies the value that is automatically entered into the user-defined field 
when a new record is created in the Product Definition application. Default values are optional.

Where Used: Engineering Database Admin

Field Name
Field Name identifies the name of the user-defined field. The first character of the field name 
must be an alpha character. Spaces are not allowed.

Note: A field name that you create cannot be a duplicate of system-defined column name or 
the same as the user-defined fields already in the system.

Where Used: Engineering Database Admin

Log File
Log File displays the contents of the log file that is created when the databases are repaired 
or compacted. Log file information can be deleted when necessary.

Where Used: Engineering Database Admin

Required
Required identifies if the user-defined field is a required or optional field. 

- Select if the specified field is a required field.

- Do not select if the specified field is optional. 
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Where Used: Engineering Database Admin

Size
Size identifies the maximum number of characters you can enter into the user-defined field. 
Size defaults to <automatic> and can only be changed for fields with a Data Type = Text. The 
maximum is 255 characters.

Where Used: Engineering Database Admin

Validation Message
Validation Message identifies the error message that appears when data is added or 
maintained in the user-defined field that is prohibited by the Validation Rule. Validation 
messages are optional.

Where Used: Engineering Database Admin

Validation Rule
Validation Rule is an expression that identifies the limits that are enforced when data is 
added or maintained in the user-defined field. Validation rules are used for calculations or to 
specify criteria or filters. If you are using Engineering with Access, you can use the Expression 
Builder to create expressions. If you are using Engineering with SQL, you must define the rule 
using the correct SQL syntax.

Where Used: Engineering Database Admin
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EIMP – Engineering Data Import
Engineering Data Import is used to import data from external sources into the Engineering Module. Data, 
such as engineering items, engineering bills of material, engineering and production reference designators 
and the linkages between engineering and production items can be imported into the Engineering 
database. 

The data from external sources is imported into the Engineering Module using an import file that is created 
by the user. See Engineering Data Import Setup for more information on the engineering data import file, 
including the required file format and layouts available when using the engineering data import 
functionality.

Engineering Data Import is divided into sections that include:

Fields
Import File

Import File identifies the source directory path and file name of the file which is being 
imported into the engineering database. The import filename must have a CSV file extension.

Where Used: Engineering Data Import

Import File Type
Import File Type identifies the type of data included in the file that is being imported into the 
engineering database. The import file type is automatically determined by the system when 
the file is opened.

Where Used: Engineering Data Import

Import Results
Import Results identifies the outcome of the engineering data import. 

• Accepted.  Identifies the number of records imported into the engineering database.

• Rejected.  Identifies the number of records in the file that were not imported into the 
engineering database.

The import data header and the data that was imported into the engineering database is 
displayed in the table.

Where Used: Engineering Data Import

Section Description

Import File Allows you to select the file to import.

Import Results Allows you to review the sample data before it is imported and review the results 
of the import.
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EITB – Item Master
Item Master is used to record each of your company's unique engineering end-product, assembly, 
component, material, tool, reference item or resource center. It is the master record for each of your items. 
Item Master contains information that identifies and describes each item used in your engineering and 
production processes.

Item Master displays parent and component item information in both a graphical hierarchy and in a table 
(row by column) format. The table format can be customized, for example, to add a second row of column 
headings, add or remove columns or change the column width.

The asterisk (*) before the field names on the Engineering Item Master indicate that the field is used in the 
Engineering module only.

Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

*Cost
Material Cost is the cost for the engineering item entered when that item is defined. It is not a 
calculated field.

Where Used: EITB; ECRL; ESMB; Engineering

Desc / *Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
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Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

*Dec Pre Cd
Decimal Precision Code represents the number of decimal places displayed and printed for 
inventory-related quantities for an item. Decimal Precision Code = 0 displays quantities 
rounded to whole numbers. However, the actual quantity is stored with all decimal places in 
the database. Entry options include:

0 = Zero positions
1 = One position
2 = Two positions
3 = Three positions
4 = Four positions
5 = Five positions
6 = Six positions
7 = Seven positions
8 = Eight positions
9 = Nine positions

Where Used: Engineering; Item Master; Item Master Planning Detail; Production; 
Workcenter Master

*Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.
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Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Filter By
Filter By is used to request the Item Master list, where the entered criteria is used to search 
the Item Master and selects all records that match the criteria. The asterisk (*) is the only wild 
card character allowed and it must be entered in the first position. For example, entering "*1" 
in the Item field lists all items that have a "1" somewhere in the item identifier, such as 19-RED 
or AT-100. 

For best results, enter complete values for filtering. For example, to filter for items with a unit of 
measure of "each", enter UM = EA. Filtering would not have been successful in this example if 
you entered UM = E or UM = E* because the entered values were incomplete.

Where Used: Item Master

Fixed LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

Insp LT
Inspection Lead Time is the number of working days normally required for inspection of an 
item. It is added to run lead time and fixed lead time to estimate total planned lead time for an 
order. For purchased items, Inspection Lead Time is used to determine the required dock 
date based on the date needed in stock. Entry is up to 3 numbers.

Where Used: AVII; AVIT; IPPD; Item Availability; Item Browse Detail; Item Master; Item 
Master Planning Detail; MSMT; Production; QUOI; QUOT; Single-Level Configuration Bill of 
Material Report; Workcenter Master

Insp Reqd
Inspection Required code specifies whether incoming inspection is required for this item 
before receiving to an on-hand location. Inspection Required codes are:

Y = Yes. 
Incoming inspection is required.

N = No. 
Incoming inspection is not required.
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Where Used: AVII; AVIT; Customer Order Receipt/Reverse; Demand Peg Detail; IPPD; 
Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item Master; Item 
Master Detail; Item Master Planning Detail; ITMB; ITMI; Lot Trace; Manufacturing Order 
Receipt/Reverse; MPSR; MPSS; PORI; PORV; Production; QUOI; QUOT; SDAB; SDAL; 
Supply Peg Detail

*Item
Item is the unique identifier for a part used in the Engineering module, whether it be a piece 
part, tool, raw material, an assembly, or finished product. Within a product structure, an item 
can be a component as well as a parent. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: EITB; Engineering; ECMS; EMLB, EMWU; ESMB, ECRL

Item Status
Item Status indicates whether an item is not released for production, or is released for 
production and is active, being phased out or is obsolete. Item Status codes are:

E = Engineering. 
Indicates the item is not released for production. A warning message is displayed 
when an order for the item is added or updated.

A = Active. 
Indicates the item is released for production. The item is actively used and can be 
made or purchased.

P = Being phased out. 
Indicates the item is released for production but it will no longer be used in the 
manufacture of products after the current supply runs out. A warning message is 
displayed when a new order for the item is placed.

O = Obsolete. 
Indicates the item is released for production but is no longer used in the manufacture 
of products. Remaining inventory cannot be considered in any production plans but 
can be moved to another storage location and be adjusted for accounting purposes.

Where Used: ABCR; AVII; AVIT; Bill of Material Detail; CINV; Demand Peg Detail; FCST; 
IHIR; INVR; IORD; IPPD; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; ITHC; ITHR; ITMB; ITMI; 
Lot Trace; MPSR; MPSS; MSMT; MUSE; Production; QUOI; QUOT; SDAB; SDAL; Single-
Level Configuration Bill of Material Report; SSII; Supply Peg Detail; WUSE

*Item Type
Item Type is used to indicate whether an item is material, reference, tool or resource. You can 
enter one of four codes and Item Type can only be changed or added on the Item Master. The 
Item Types are:

N = Normal. 
The item is material consumed in the manufacture of products.
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X = Reference. 
The item appears on the bill, but is not consumed in the manufacture of its parent, 
such as a drawing.

T = Tool. 
A tool is used to manufacture its parent.

R = Resource. 
This item is used in the planning process of the manufacture of its parent, such as 
labor hours.

Where Used: AVII; AVIT; Bill of Material Detail; Demand Peg Detail; FCST; IHIR; INVR; 
IORD; IPPD; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; ITHC; ITHR; ITMB; ITMI; Lot Trace; 
MPSR; MPSS; MSMT; MUSE; PBCI; PBCT; Picklist Detail; Production; QUOI; QUOT; SDAB; 
SDAL; Single-Level Configuration Bill of Material Report; SSII; Supply Peg Detail; WUSE

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

*Matl Cost
Material Cost is the cost for the engineering item entered when that item is defined. It is not a 
calculated field.

Where Used: EITB, Engineering

*MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
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Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Ord Pol
Order Policy is established for each item based on how planned orders for the item are 
handled. Order Policy provides replenishment order information used by the planner or 
buyer. Order Policy codes are:

0 = No Planning. 
No planning requirements are generated for this item.

1 = Order Point. 
When an item's supply falls below the Order Point quantity, the system recommends 
placing an order. The recommended order quantity is the Lot Size Qty.

2 = Order-Up-to. 
When an item's supply falls below the Order Point quantity, the system recommends 
placing an order. The recommended order quantity is 

(Order Up to) - (On Hand Inv) - (Insp Qty) - (On Order Quantity) + 
(Allocations), 

as modified by Lot Size Min and Lot Size Mult.

3 = Period Order. 
When the demands generated by MRP exceed supply, the system recommends 
placing an order. Recommended order quantity covers all demands within the period 
indicated by Lot Size Day, as modified by Lot Size Min and Lot Size Mult.

4 = Fixed Order. 
When the demands generated by MRP exceed supply, the system recommends 
placing an order. The recommended order quantity is the Lot Size.

5 = Manual Planning. 
When the demands generated by MRP exceed the supply, the system notifies the 
planner/buyer. The lot size quantity is used to recommend an order quantity.

Order Policy affects how the system uses lot size specifications, order points, on hand 
inventory, on order inventory and safety stock.

Where Used: ABCR; Bill of Material Detail; Demand Peg Detail; IORD; IPPD; Item Browse 
Detail; Item History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; 
Item Master Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; MSMT; Production; 
SDAB; SDAL; Single-Level Configuration Bill of Material Report; SSII; Supply Peg Detail
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Phase
Phase Name is the name assigned to each of the product release levels. Default phase 
names which are installed with the system include:

0 = Engineering. 
 Item is in the engineering database but not in the production database.

1 = Pre-Production. 
 Item is in the production database with an Item Status = E (engineering, not released 
for production).

2 = Production. 
 Item is in the production database with an Item Status = A (active).

On the Item Master, an item can have a Phase Name = -1 (Error) if it was selected for 
promotion but it did not pass the promotion rule conditions. After resolving the errors, the item 
can be promoted to the next release level.

Default phase names can be customized using the PRRD functionality. Entry is any 
alphanumeric combination up to 30 characters.

Where Used: Item Master; Product Release Rule Definitions

Phase Date
Phase Date is the day, month and year that an item changed release status, for example the 
date an item was promoted to the next level phase.

Where Used: Item Master

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

*Price
Price is the price for the engineering item entered when that item is defined. It is not a 
calculated field. 
Engineering 118



Fourth Shift Release 8.00 EITB – Item Master
Where Used: EITB, Engineering

*Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master

SI
Saleable Indicator is used for reference and extract purposes to indicate whether an item is 
available for forecasting. Saleable items may include end-items, spare parts or repair items. 
Entry options include: 

Y = Yes. 
Item is available for forecasting.

N = No. 
Item is not available for forecasting.

blank = No. 
Item is not available for forecasting.

Default is blank. Saleable Indicator is only available if the Forecast Management Module is 
installed.
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Where Used: Item Master; Item Master Detail

Sr
Serialization indicates whether serial numbers should be recorded at the time of shipment.

Y = Yes. 
Serial numbers are recorded.

N = No. 
Serial numbers are not recorded.

Where Used: Bill of Material Detail; Item Browse Detail; Item History; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; ITMB; ITMI; 
Lot Trace; MPSR; MPSS; Production; SSII

Starting At
The Starting field is used to request a list where the specified information appears first on the 
list. Starting entries may consist of a partial entry and if the entry is not in the list, the next 
highest entry appears first on the list. The Starting field can include one or more field 
combinations, each with its own entry requirements.

Where Used: A/P 1099 Distribution; A/P Payment Application Detail; A/P Payment Void 
Detail; A/P Received Item List; A/P Receiving Detail; A/R Payment Application Detail; APAH; 
APDS; APEX; APID; APIE; APII; APIR; APIV; APPA; APPD; APPI; APPO; APTX; ARAH; 
ARCD; AREX; ARIC; ARIH; ARPD; ARPH; ARSR; BAMT; Bank Payment Approval; BILI; 
BILL; BKMT; Browse Setup (customer); Browse Setup (item); Browse Setup (vendor); CACF; 
CCAN; CCAT; CCEX; CCMT; CIMT; CMCF; CMTA; CMTI; CNFA; COAN; COMI; COMT; 
Contract Item Detail/Pricing; CORV; CPMT; CUID; CUII; CUSI; CUST; FCMT; FCST; G/L 
Account Group/No List; G/L Account No List; G/L Batch Detail; G/L Journal Entry List; G/L 
Master Account Recap; G/L Org No List; G/L Org/Acct Group List; G/L Organization Group/No 
List; G/L Report List; G/L Source Code List; GLAG; GLAV; GLBD; GLCA; GLCI; GLDQ; 
GLEX; GLGQ; GLJD; GLJE; GLJI; GLJP; GLJR; GLMA; Global Extended Text Selection; 
GLOS; GLRD; GLRL; GLSC; GLSI; GLSS; ITBI; ITCB; Item Master; Item Shortages; ITMB; 
ITMI; ITPB; ITPI; IVCO; IVIA; IVIE; IVII; IVRV; LMMT; Location Selection Setup; MCST; 
MOAN; MOMI; MOMT; MORI; MORV; MPED; MPIT; MSMT; NMTA; OPSL; Orders on 
Shipment; ORST; Packaging Detail; PASS; PBCI; PBCT; PBMI; PBMT; PCMT; PCST; PICI; 
PICK; POAN; POAS; POCI; POCT; POMI; POMT; PORI; PORV; REDI; RTMT; RVED; SBOL; 
Selection Setup; Serial Number List; Serial Numbers Shipped; SHIP; Shipments by Line Item; 
SHPI; SSII; STAD; SUND; SUNR; SUPD; SUPR; TEXT; TXTA; VAT Summary (APSM 
Module); VATT; VEDI; VEID; VEND; VENI; Workcenter Master

*UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
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Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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EMLB – Multi-Level Bill
Multi-Level Bill is used to view a parent items' multi-level product structure as of a user-specified effectivity 
date. You can view a flattened bill format by exploding phantom components. Multi-Level Bill also allows 
you to view the complete item change history as of a specific revision level or effectivity date.

Multi-Level Bill displays component item information in a table (row by column) format based on the 
information entered in the Parent and Component Effectivity Date fields.

The Multi-Level Bill functionality is the same regardless of how it is accessed.

Reports

Multi-Level Bill Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists components by level for a multi-level engineering bill.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Multi-Level Bill

Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 

Report Title

Engineering Multi-Level Bill
Lists components by level for a multi-level engineering bill.

Production Multi-Level Bill
Lists components by level for a multi-level production bill.
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Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
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Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
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The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Cum LT
Cumulative Lead Time is the number of shop days to manufacture an item from start to 
finish—from initially placing a purchase order for raw material through each level in the 
product structure to completion of the item. Cumulative Lead Time is based on the critical 
path of components in the item's multi-level bills of material and the component lead times.

Where Used: Multi-Level Bill
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Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.
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Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Fixed LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

In Effectivity
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

In Rev
In Revision Level indicates the level of documentation for which the parent-component 
relationship becomes effective. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Item
Item is the unique identifier for a part used in the Engineering module, whether it be a piece 
part, tool, raw material, an assembly, or finished product. Within a product structure, an item 
can be a component as well as a parent. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: EITB; Engineering; ECMS; EMLB, EMWU; ESMB; ECRL

Level
Item Level indicates the position of an item within a product structure. Level is used to show 
the relative position of an item in relationship to its higher-level parent or lower-level 
components. Entry is any alphanumeric combination.
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Where Used: CMLB; Location Index; LOTR; MBIL; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

LT Offset
Lead Time Offset is the number of days after the order start date that a component is needed 
in the manufacturing process. Entry is up to 3 numbers. Default value is 0.

Where Used: BILL; Bill of Material Detail; Demand Peg Detail; Lead Time; Lead Time 
Analysis; Material Exposure; MBIL; Multi-Level Bill; Multi-Level Where Used; Production; 
Single-Level Configuration Bill of Material Report

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
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QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Out Effectivity
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Out Rev
Out Revision Level indicates the level of documentation for which the parent-component 
relationship is no longer in effect. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
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Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
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LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Ref Des Count
Reference Designator Count is the total number of unique reference designator identifiers 
entered as Reference Designators associated with a component. For example, the 
Reference Designator Count = 3 for reference designators entered as a range of D1-D3 for a 
specified component.

Where Used: Bill of Material; Comparison Bill; Multi-Level Bill; Where Used
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Reference Designators
Reference Designators are unique identifiers which allow engineers to assign control 
information such as device callouts to a component within a Bill of Material. Ranges can be 
used to organize multiple sequential reference designator identifiers. Entry is up to 10 
characters.

Where Used: Bill of Material; Comparison Bill; Engineering; Exceptions; Multi-Level Bill; 
Where Used

Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.
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Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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EMWU – Multi-Level Where Used
The Multi-Level Where Used is used to list all parent items that directly use a specific component. The list 
displays the single level relationship between a component and all parent items at the next highest level. 
You can also view Item Master detail, such as packaging, planning and stock status information. 

Multi-Level Where Used is useful to view end item pegging information, since only the top level, or end 
items, are displayed. Multi-Level Where Used is also useful in making mass engineering changes using 
the Mass Change ability, because it shows where a given component is used throughout your company's 
bills of material.

The Multi-Level Where Used displays parent and component item information in both a graphical hierarchy 
and in a table (row by column) format. The table format can be customized, for example, to add a second 
row of column headings, add or remove columns or change the column width.

Reports

Multi-Level Where Used Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists parents by level where an engineering component is used.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Multi-Level Where Used

Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Report Title

Engineering Multi-Level Where Used
Lists parents by level where an engineering component is used.

Production Multi-Level Where Used
Lists parents by level where an production component is used.
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Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE
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Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.

Where Used:AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used
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Fixed LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

In Effect
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

In Rev
In Revision Level indicates the level of documentation for which the parent-component 
relationship becomes effective. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Item
Item is the unique identifier for a part used in the Engineering module, whether it be a piece 
part, tool, raw material, an assembly, or finished product. Within a product structure, an item 
can be a component as well as a parent. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: EITB; Engineering; ECMS; EMLB, EMWU; ESMB; ECRL

Level
Item Level indicates the position of an item within a product structure. Level is used to show 
the relative position of an item in relationship to its higher-level parent or lower-level 
components. Entry is any alphanumeric combination.

Where Used: CMLB; Location Index; LOTR; MBIL; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE
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LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

LT Offset
Lead Time Offset is the number of days after the order start date that a component is needed 
in the manufacturing process. Entry is up to 3 numbers. Default value is 0.

Where Used: BILL; Bill of Material Detail; Demand Peg Detail; Lead Time; Lead Time 
Analysis; Material Exposure; MBIL; Multi-Level Bill; Multi-Level Where Used; Production; 
Single-Level Configuration Bill of Material Report

Out Effect
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Out Rev
Out Revision Level indicates the level of documentation for which the parent-component 
relationship is no longer in effect. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
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Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
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Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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ESMB – Summarized Bill
Summarized Bill allows you to perform "what if" cost and inventory impact analysis by comparing multi-
level bills of material where each of the components is listed once with an aggregated quantity. 
Summarized Bill is used to:

• plan for optimal material usage during product phase-out

• assess cost/inventory implications of unplanned impact orders

• generate prioritized material expedite lists

Summarized Bill displays component item information in a table (row by column) format based on the 
information entered in the Parent and Component Effectivity Date fields. 

Features available are based on user job functions:

When accessed from the MMAM Module, Summarized Bill analysis calculates summarized, consumed 
and required quantity and cost information based on a specified Prod Qty (production quantity) value. 
Information calculated includes:

The Summarized Bill of Material reports available can be sorted in a variety of ways. See "Generating 
Reports" in the Setting Up the Module section of the Manufacturing Analysis manual for more 
information.

Reports

Summarized Bill Reports

Access From Features

ENGM Module Present a multi-level bill where each of the components is listed once with an 
aggregated quantity. Quantities are aggregated based on make buy (MB), quan-
tity type (QT) and component type (CT).
For example, you may need a purchase requisition for materials still in the engi-
neering phase that means the materials are not in the Fourth Shift inventory. You 
can use the summarized bill of material with aggregated quantities to show your 
material requirements in order to get a purchase requisition.

MMAM Module Present a multi-level bill by specifying a product quantity and an item type to con-
sume. Choose to view data from several pre-defined views, such as Summarized 
Bill by Lead Time or Required Quantity.

Information 
calculated Description

Summarized total quantity/cost needed to produce the Prod Qty specified, taking scrap and 
yield into account.

Consumed quantity/cost taken from Available inventory to fulfill the production of the Prod 
Qty specified

Required quantity/cost, in addition to the consumed amount, needed to fulfill the production 
of the Prod Qty specified
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To generate the report, choose Print Preview from the File menu.

Report Description
Lists aggregated quantities for summarized engineering components.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Summarized Bill

Fields
Allocations

Allocated is the number of units committed to released customer orders.

Where Used: Inventory Status; Item + Quantity; Item Availability + Quantity; Summarized 
Bill

Available
Available is the calculated amount of item inventory that may be applied to satisfy the 
Summarized Quantity of a component necessary to build the Prod Qty of a parent assembly. 
Available inventory types include: On-Hand, On-Hold, In-Inspection, In Shipping.

Where Used: Summarized Bill

Available Qty
Available Quantity is the user-defined formula used to calculate the quantity available for the 
purpose of fulfilling the simulated Prod Qty. Available Quantity is increased when the 
following are selected:

On-hand (O)
In-Inspection (adjusted for yield) (I)
On-Hold (H)
In WIP (W)

Report Title

Engineering Summarized Bill
Lists aggregated quantities for summarized engineering components.

Production Summarized Bill
Lists aggregated quantities for summarized production components.
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In shipping (S)
On-Order (R)

Available Quantity is decreased when the following is selected:

Allocations from other orders (A)
The Available Quantity definition is displayed using the abbreviations in parenthesis. The 
default calculation is:

[On-Hand + (In-Inspection * Yield)] - (Allocations from other 
orders)

Where Used: Material Exposure; Summarized Bill

Average Cost Consumed
Average Cost Consumed is the average calculated value of the Consumed Quantity in 
order to fulfill the simulated Prod Qty. The calculation is:

Extended Cost Consumed / Prod Qty

Where Used: Summarized Bill

Average Cost Required
Average Cost Required is the average calculated value of components needed in addition to 
the Consumed Quantity in order to fulfill the simulated Prod Qty. The calculation is:

Extended Cost Required / Prod Qty

Where Used: Summarized Bill

Average Cost Total
Average Cost Total is the average total calculated value of components needed to fulfill the 
simulated Prod Qty. The calculation is:

Average Cost Required + Average Cost Consumed

Where Used: Summarized Bill

Buyr
Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
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POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE
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Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

Consume Avail
Consume Avail defines what types of items are obtained from the Available Quantity to fulfill 
the simulated Prod Qty.

0 = Buy items only
1 = Make/Buy items (no phantoms)
2 = All items
3 = No items

Where Used: Summarized Bill

Consumed Item Cost
Consumed Item Cost is the per unit total rolled cost of an item as displayed on the ITMC 
(Item/Work Center Cost Data) screen at the time it is displayed. The consumed item cost 
answers the "what if" question of how much did it cost to produce an item currently available to 
be consumed.

Where Used: Summarized Bill

Consumed Quantity
Consumed Quantity is the number of components taken from Available Quantity to fulfill the 
simulated Prod Qty.
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Where Used: Summarized Bill

CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.
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Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.
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Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Effectivity Date
Effectivity Date is the effectivity date specified the last time the CROL task was run.

Where Used: CMLB; CSLB; Summarized Bill

Extended Cost Consumed
Extended Cost Consumed is the calculated value of all components taken from Available 
Quantity in order to fulfill the simulated Prod Qty. The calculation is:

Consumed Quantity * Cost Definition of Standard Cost

Where Used: Summarized Bill

Extended Cost Required
Extended Cost Required is the calculated value of all components needed in addition to 
those taken from Available Quantity to fulfill the simulated Prod Qty. The calculation is:

Required Quantity * Cost Definition of At This Level Cost

Where Used: Summarized Bill

Extended Cost Total
Extended Cost Total is the total calculated value of the items needed to fulfill the simulated 
Prod Qty. The calculation is:

Extended Cost Consumed + Extended Cost Required

Where Used: Summarized Bill
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Inventory
Inventory identifies the quantity of inventory stored in a stock and bin location. Inventory types 
includes allocated, in-inspection, in shipping, internal WIP, external WIP, on hand, on hold and 
on order.

Where Used: Summarized Bill

Item
Item is the unique identifier for a part used in the Engineering module, whether it be a piece 
part, tool, raw material, an assembly, or finished product. Within a product structure, an item 
can be a component as well as a parent. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: EITB; Engineering; ECMS; EMLB, EMWU; ESMB; ECRL

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

Make / Buy Cost
Make / Buy Cost is the user-defined formula used to calculate the Total Cost for make and 
buy items. Cost definitions for make and buy items can include the following costs:

Material (M)
Labor (L)
Variable overhead (V)
Fixed overhead (F)

The Make / Buy Cost definition is displayed using the abbreviations in parenthesis. 

Where Used: Material Exposure; Summarized Bill

Matl Cost
Material Cost is the cost for the engineering item entered when that item is defined. It is not a 
calculated field.
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Where Used: EITB; ECRL; ESMB; Engineering

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

On Order
On Order Quantity is the total number of items on open or released manufacturing and 
purchase orders (Ln# Sta = 3 or 4).

Where Used: Inventory Status; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Shortages; Location Index; Material Shortages Detail; Production; Shortages by 
Order; SSII; Summarized Bill

Order Related Total
Order Related Total is the total cost of all components (Quantity Type = O) and their 
subordinates. The Order Related Total cost is included in the Extended Cost and in the 
Average Cost and is amortized over the parent Prod Qty.

Where Used: Summarized Bill

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
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Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Prod Qty
Production Quantity is the number of parent items for which you want to analyze component 
impact. Entry is 1 - 9999999999.

Where Used: Summarized Bill

Pt Use Defines Embedded Revision
Pt Use Defines Embedded Revision specifies the three key characters in the Pt Use field 
that uniquely identify revision history components in a bill of material. The recommended value 
is REV. If REV has previously been used to define a workcenter, another identification prefix 
must be used.

Where Used: Bill of Material; Summarized Bill

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Required Item Cost
Required Item Cost is the per unit cost calculated at the time it is displayed based on the 
multi-level bill content and the At This Level Costs defined at the time of the simulated cost 
roll. The required item cost answers the "what if" question of how much will it cost if the 
required item had to be built.

Where Used: Summarized Bill

Required Quantity
Required Quantity is the number of components needed in addition to the Consumed 
Quantity to fulfill the simulated Prod Qty.

Where Used: Summarized Bill

Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Stock/Bin Locations
Available Stock/Bin Locations is the user-defined formula to specify which stock and bin 
locations are calculated in Available Quantity. You can specify to include the following:

all stock / bin locations
include only specific stock / bin locations 
exclude specific stock / bin locations

Default is to include all stock / bin locations in the available quantity.

Where Used: Summarized Bill
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Summarized Quantity
Summarized Quantity is the total number of components needed to fulfill the simulated Prod 
Qty.

Where Used: Summarized Bill

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
Engineering 156



Fourth Shift Release 8.00 EWUS – Where Used
EWUS – Where Used
Where Used is used to list all parent items that directly use a specific component. The list displays the 
single level relationship between a component and all parent items at the next highest level. You can also 
view Item Master detail, such as packaging, planning and stock status information.

Where Used is useful in making mass engineering changes using the Mass Change ability, because it 
shows where a given component is used throughout your company's bills of material.

Where Used displays parent and component item information in both a graphical hierarchy and in a table 
(row by column) format. The table format can be customized, for example, to add a second row of column 
headings, add or remove columns, or change the column width.

Reports

Where Used Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists parents where an engineering component is used.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Where Used

Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 

Report Title

Engineering Where Used Bill of Material
Lists parents where an engineering component is used.

Production Where Used Bill of Material
Lists parents where a production component is used.
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Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE
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Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.
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Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Fixed LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

In Effectivity
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

Out Effectivity
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE
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Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.
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Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Ref Des
Reference Designators are unique identifiers which allow engineers to assign control 
information such as device callouts to a component within a Bill of Material. Ranges can be 
used to organize multiple sequential reference designator identifiers. Entry is up to 10 
characters.
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Where Used: Bill of Material; Comparison Bill; Engineering; Exceptions; Multi-Level Bill; 
Where Used

Ref Des Count
Reference Designator Count is the total number of unique reference designator identifiers 
entered as Reference Designators associated with a component. For example, the 
Reference Designator Count = 3 for reference designators entered as a range of D1-D3 for a 
specified component.

Where Used: Bill of Material; Comparison Bill; Multi-Level Bill; Where Used

Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master

Rv
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.
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Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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PRRD – Product Release Rule Definitions
Product Release Rule Definitions is used by product release managers to set up the conditions and define 
the rules that are considered when an item is being released to the next release phase.

• Set Up Conditions. Users set up selection and edit condition criteria which is used to 
evaluate the item prior to release. 

• Define Rules. Users create rules and then assign conditions to the rules based upon your 
company’s specifications. Two sets of rules are defined for releasing items: rules to release 
from Phase 1 to Phase 2 and rules to release from Phase 2 to Phase 3. Rule severity, warning 
or failure must be assigned to each rule.

Product Release Rule Definitions is divided into sections which include:

Fields
Phase Name

Phase Name is the name assigned to each of the product release levels. Default phase 
names which are installed with the system include:

0 = Engineering. 
 Item is in the engineering database but not in the production database.

1 = Pre-Production. 
 Item is in the production database with an Item Status = E (engineering, not released 
for production).

2 = Production. 
 Item is in the production database with an Item Status = A (active).

On the Item Master, an item can have a Phase Name = -1 (Error) if it was selected for 
promotion but it did not pass the promotion rule conditions. After resolving the errors, the item 
can be promoted to the next release level.

Default phase names can be customized using the PRRD functionality. Entry is any 
alphanumeric combination up to 30 characters.

Where Used: Item Master; Product Release Rule Definitions

Rule
Product Release Rule is the definition used as criteria for promoting items between the three 
specified release levels, or phases. Rules are assigned selection and edit conditions. To aid 
the product release manager, sample rule definitions are included which can be customized 

Tab Title Description

Selection/Edit Conditions
(left side)

Used to set up and define the selection and edit condition criteria 
which is used to evaluate the item prior to release.

Rules
(right side)

Used to create rules and then assign selection and edit conditions. 
Also used to determine the rule severity (warning or failure).
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for your specific release requirements. Entry is any alphanumeric combination up to 50 
characters.

Where Used: Product Release Rule Definitions

Selection/Edit Condition
Product Release Condition identifies the selection and edit criteria which is used to evaluate 
the item prior to promotion. Selection criteria determines which items are selected for 
promotion. Edit criteria determines specific field relationships and values. To aid the product 
release manager, sample selection and edit conditions are included which can be customized 
for your specific release requirements.

Where Used: Product Release Rule Definitions
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